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IEVADS

ST rokasgramata ir veidota Tiesu administracijas Eiropas Komisijas nacionalo vai starptautisko e-
tiesiskuma projektu programmas ,TIESISKUMS (2014-2020)” projekta “ECLI ievieSana” (nr.
JUST/2014/JACC/AG/E-JU/6975) ietvaros.

Rokasgramata ir aprakstita programmas SDL Trados Studio un risindjuma SDL GroupShare versija 2015,
ka art attéloti $ai versijai atbilstoSie saskarnes elementi. Citas programmas versijas iespéjamas atskiribas no
Saja dokumenta aprakstitas versijas, tadé] to var izmantot citu programmu versiju darbibas pamatprincipu
apglsanai, bet ne ka pilnvértigu celvedi to lietoSana. Programmas SDL Trados Studio 2015 darbinasanai
nepiecieSams dators ar Sadiem parametriem:

e operétajsistémas Windows 7 SP1, 8.1 vai 10;

e 2 GB brivas vietas cietaja diska;

e 2 GB operativas atminas (datoriem ar 32 bitu procesoru);
e 4 GB operativas atminas (datoriem ar 64 bitu procesoru);
e ekrana izSkirtspéja 1280x1024 pikseli vai lielaka.

Rokasgramata ir paredzéta Latvijas Republikas Tiesu administracijas sistemu administratoriem un IT
atbalsta specialistiem, kuri ir piedalijusies 1 projekta ietvaros rikotas apmacibas darbam ar SDL Trados Studio
2015 un SDL GroupShare 2015. Ta ir veidota iespéjami detalizéti un visaptverosi, lai ta bdtu noderiga gan
sistému administratoriem, kuri darbosies ar SDL GroupShare serveri, gan IT atbalsta specialistiem, kuri sniegs
tehnisku atbalstu tiesu tulkotajiem un SDL Trados Studo 2015 lietotajiem. Taja pat laika rokasgramata ir
veidota, nemot véra mérkauditorijas padzilinatas zinasanas informacijas tehnologiju joma. Tadé| taja nav
izmantoti |oti vienkarsoti funkciju un veicamo darbibu apraksti, ka tas ir lietotaju rokasgramata

Dokumenta pirmaja nodala aprakstita programmas uzstadiSana, konfigurésana, un lokalo resursu
parvaldiba. ST nodala satur administratoriem un tehniska atbalsta persondlam noderigu informaciju, kas
papildina tulkotaju rokasgramata atrodamos programmas darbibas principu un funkciju izklastus. Otra
nodala ir veltita GroupShare servera un ta resursu parvaldibas galvenajam funkcijam. Seit atrodama
informacija par lietotajiem, lietotaju lomam un piekluves tiesibam, ka ari par serverbazéto tulkoSanas atminu
parvaldibu. Tresaja nodala apkopota informacija par problému novérsanu, t.i., biezak sastopamo problému
apraksts un veicamas darbibas to risinasanai, ka ar ricibas iesp€jas citu problému gadijuma.

Pamaciba ir izmantoti dazadi teksta formatéjumi noteiktu elementu izcelSanai.
Teksts zala krasa: saskarnes elementi, pieméram, pogas, izvélnes, cilnes un sadalas.
Teksts sarkana krasa: mapes atrasanas vieta.
Teksts slipraksta: programma sastopams vai cits teksts anglu valoda, pieméram, Source Language.

Teksts treknraksta vai ar _pasvitrojumu: izcelts teksts, lai padaritu to pamanamaku un pievérstu lasitaja
uzmanibu.

Tapat dokumenta ir izmantoti talak redzamie informacijas un bridinadjuma elementi.

Informéjo3a piezime. Sadas Bridinajums. Sadi bridinajumi satur
piezimes satur noderigu loti svarigu informaciju. Noteikti
informaciju un padomus saistiba ar nemiet to véra! Pretéja gadijuma
attiecigo temu. var rasties programmas darbibas

traucéjumi vai nevélamas veikto
darbibu sekas.



Tsuma par SDL Trados Studio

SDL Trados Studio ir tulkosanas programma, kas tulkoSanas nozaré ir viena no plasak zinamajam un
lietotajam programmam. Turklat Sai programmai regulari tiek izstradatas jaunas versijas, tadéjadi attistoties
[[dz ar jaunakajam tehnologijam, ka arm uzlabojot esoSos un ievieSot jaunus rikus un funkcijas, kas palidz
tulkotajiem veikt darbu efektivi un kvalitativi.

SDL Trados Studio programma sniedz iespéju tulkot daudz dazadu formatu failus érta un viegli
parskatama saskarné, kas lauj tulkotajam koncentréties uz teksta saturu un mazak domat par dokumenta
struktiras atveidoSanu. Turklat péc tulkoSanas ieguta faila formats un formatéjums atbilst originalajam
dokumentam.

Lai nodrosinatu teksta parskatamibu un programmas funkcionalitati, tulkojamais teksts automatiski
tiek sadalits segmentos. Parasti viens segments satur vienu teikumu, virsrakstu vai tamlidzigu teksta vienibu.

Programma Trados Studio atskiras no automatizétas tulkoSanas programmam, pieméram, plasi
zinamas Google Translate, ar to, ka programma pati neveic tulkosanu. Trados Studio pamatprincips ir
iztulkoto vienibu jeb segmentu saglabasana tulkoSanas atmina. Péc tam, ja cita teksta ir tads pats vai lidzigs
segments, programma piedava atmina saglabato segmenta tulkojumu, tadéjadi nodrosinot, ka tulkotajam
nav atkartoti jatulko ieprieks tulkots teksts. Pie tam, izmantojot serverbazétu tulkoSanas atminu, tulkotajam
ir pieejami art tulkojumi, kurus ir veikusi citi $1s atminas lietotaji.

Papildus tulkoSanas atminam ir iespéjams izmantot terminologijas datu bazes, lai nodroSinatu
pareizu un konsekventu terminologiju. Sis terminologijas datu bazes balstas uz tulko$anas atminai lidziga
principa, proti, tas parasti papildina lietotaji jeb tulkotaji. Terminologijas datu bazes var veidot katrs lietotajs
atseviski vai kopigi ar citiem lietotajiem izmantot serverbazétu terminologijas datu bazi.

Ertakai tulko3anas darbu organizé3anai SDL Trados Studio izmanto projektus. Projekta ir apkopoti
noteikta tulkosanas darba tulkojamie faili, tulkoSsanas resursi (tulkoSanas atminas un terminologijas datu
bazes), ka arT katram projektam ir iespéjams individuali konfigurét iestatljumus. Tadejadi ir iesp&jams
pielagot resursus katra tulkoSanas darba specifikai un tulkotaja vajadzibam.

Papildus tulkosanas un terminologijas datu bazém SDL Trados Studio ir aprikota ar daudzam dazadam
papildu funkcijam, kas palidz nodroSinat tulkojuma kvalitati un iespéju pilnvértigi izmantot programmas
sniegtas priekSrocibas. JUs varat, pieméram, parbaudit tulkojuma teksta pareizrakstibu, priek$skatit
tulkojumu pirms tulkota faila saglabasanas, sekot lidzi iztulkotajam apjomam un izmantot citas produktivitati
veicinosas funkcijas.



1. PROGRAMMAS SDL TRADOS STUDIO PARVALDIBA

Saja nodala ir apkopota informacija par tulkotaja darbstacijas sagatavo$anu darbam ar programmam SDL
Trados Studio un SDL MultiTerm, programmu jauninajumiem un saderibu ar citam versijam, ka arl
informacija par programmas pamatprincipiem un lokalo tulkoSanas resursu parvaldibu.

1.1. INSTALACIJA

Programmas tiek instalétas ar vedna palidzibu. NodroSiniet, ka instalacijas process tiek palaists ar
administratora tiestbam. SDL Trados Studio instalétaja nav ieklauta programma SDL MultiTerm — ta ir
jainstalée atseviski.

Programma SDL Trados Studio 2015 tiks instaléta Saja mapée:
%programfiles (x86)%\SDL\SDL Trados Studio\Studio5
Programma SDL MultiTerm 2015 tiks instaléta Saja mapé:
%programfiles(x86)%\SDL\SDL MultiTerm\MultiTerml2
Programmu darbibai ir nepiecieSami ari sadi komponenti:

e Microsoft .NET Framework 4.5.2;
e Microsoft Visual C++ 2013 Redistributable;
e Microsoft Visual C++ 2010 Redistributable;

Microsoft Visual C++ 2008 Redistributable SP1.

Ja instalacijas laika tie datora netiks atrasti, SDL Trados Studio vai SDL MultiTerm instalacijas vednis piedavas
iespéju tos lejupieladét un instalét. Sie papildus komponenti nav ieklauti programmu instalétajos, tadél to
lejupieladei ir nepiecieSams interneta savienojums. Ja interneta savienojums nav pieejams vai ir ierobezots,
papildu komponentus ir iespéjams lejupieladét un uzinstalét atseviski véelak.

1.2. PROGRAMMAS ATJAUNINASANA

Programmam SDL Trados Studio un SDL MultiTerm ir automatiskas atjauninajumu meklésanas funkcija.
Péc programmas palaiSanas ta komunicé ar SDL RIS
serveri un parbauda atjauninajumu pieejamibu. Ja  update Available t
ir pieejami atjauninajumi, programma parada SDL <
attéla pa labi redzamo logu, kura lietotajam tiek
pledavata.lespeja tO_S lejupieladét un InSta_|Et (poga This release includes enhancements and bug fixes for SDL Trados
Yes) wvai turpinat programmas lietoSanu, Studio 2015 SR,
neinstaléjot jauninajumus (poga No).

Mare inform ation can be found on our web site at the S0OL
Automatiskos atjauninajumus ir iespéjams atslégt, Knowdedge Base.
dodoties uz File > Options >Automatic Updates.

Would vou like to download and apply this update now ?
Atjauninajumu pieejamibu var parbaudit ari
manuali, izmantojot cilné Help atrodamo funkciju
Check for Updates.

Installed program Your Latest Download

VEersion WErSion size

Tes Mo |

Programmai ir pieejams arl atseviSks Attéls Nr. 1: SDL Trados Studio atjauninajumu instalacijas logs.
atjauninajumu veids — servisa pakotnes. Ja
programmai ir pieejama jauna servisa pakotne, péc automatiskas atjauninajumu parbaudes lietotajs sanems
pazinojumu par tas pieejamibu.

Servisa pakotne ir [idzvértiga jaunai programmas instalacijai, jo ta aizstaj veco programmas versiju.
Tadel servisa pakotnu instalacijai ir nepiecieSamas administratora tiesibas.



Péedejais jauninajumu veids ir pareja no vienas |[EETRETETUES
programmas versijas uz citu (piem. no SDL Trados  ‘pdateAvailable SDL\
Studio 2014 uz 2015). Atskirtba no servisa pakotném, :
parejot uz jaunu programmas versiju, ta neaizvieto SDL Trados Studio 2015 SR3
iepriek§éj0 VerSiju, bet t|ek instaléta paraléli tal An update release it available on the SDL website that contains further updates and

i . . _. . _ . enhancements to this praduct.
TadeJadI IIetOtaJS var darbOtIes ar a?am VerSIJam’ ;Uduﬁnluad‘jtlhaupfdalejrele;se, ghct’the"SDJIF_ACCUUEI"bultur;urviswl b Iocal v
pll’mS pllnTgaS pél’ejas uz Jauno VerSIJu ST Jaunlnéjumu ritgtﬁtss ms;;jr cg;r;u‘laeslptnpxrr?stl;ﬁtif szlfaccounts in your browser. rou must have local administratar

ve | d a | nsta I é CIJ a | | r ne p | ec |e§a mas a d m | n IStratO ra 1 you do not wish to be reminded again when the application starks, pou can turn update checks
. _b off in File > Options > Automatic pdates
tiesibas.

Piezime  attiectba uz vecakas versijas
atinstaléSanu: ja datora vienlaikus ir instalétas
vairakas programmas versijas, péc vecakas versijas _ soiacoom |
atinstalésanas no Windows registra tiek dzéstas SDL
failu (.sdIxliff, .sdlproj, .sdltm, .sdltb, u.c.) asociacijas ar
SDL Trados Studio. Tadé| péc atinstalésanas ir vélams vadibas paneli jaunajai programmas versijai palaist
funkciju Repair (Control Panel > Programs and Features > Uninstall or change a program), lai atjaunotu SDL
failu asociacijas.

Attéls Nr. 2: logs, kas informé par pieejamu servisa pakotni.

P&c vecakas programmas versijas atinstaléSanas no Windows registra tiek dzéstas SDL
failu asociacijas ar Trados Studio. Péc atinstaléSanas vadibas paneli palaidiet jaunajai
versijai funkciju Repair.

1.3. LICENCESANA

Saja nodala ir apkopota informacija par programmas licencé$anu un pieejamiem licenéu aktivizacijas un
deaktivizacijas veidiem. Pirmas 30 dienas péc programmas instalacijas ta darbojas Professional versijas
izméginajuma rezima.

Product Activation
Ja programma nav aktivizéta, palaiZot to, paradas
SDL Trados Studio 2015 Product Activation
a Wiew and manage your SOL Trados Studio 2015 license.

Product Activation logs (skat. Attéls Nr. 5). Taja ir

iespéjams aktivizét programmu, spieZot uz pogas
Activate un ievadot aktivizacijas kodu, kuru iegsiet
OO0S SDL profila.

programma Trados Studio dodoties uz cilni Help > License Expired
Product Activation.

Product Activation logu var atvért ari manuali, @ Active License:

4?/ Activate

Product Activation loga var gan
akitivizeét, gan deaktivizét licenci.

SDL Account  Purchase a license

Noklikskinot uz pogas Activate, tiek atverts

Online Activation logs (skat. Attéls Nr. 5). Si ir
tieSsaistes  aktivizacijas metode, tade] tai ir gg

nepiecieSams interneta savienojums, lai apstiprinatu Attzls Nr. 3: produkta aktivizacijas logs.
licences koda aktivizaciju SDL serverl. levadiet licences
kodu attiecigaja lauka un nospiediet pogu Activate.

Ja nav pieejams interneta savienojums vai neizdodas aktivizét programmu ar tieSsaistes metodi, ir
pieejama ari bezsaistes aktivizacijas funkcija Offline Activation. Lai to izmantotu, Product Activation loga
izvélieties iespéju Alternative activation options (skat. Attéls Nr. 4).



Product Activation

Online Activation
‘& Activate the product aver the Internet.

Product Activation

Alternative Activation Oplions
t Select an alternative activation option to activate the product,

Activation code: I\ _TEIJ

v Ativate

SDL Aocount  Alternative activation options

Help | Cancel

Attéls Nr. 5: tieSsaistes aktivizacijas logs.

Activate offline if thiz computer iz not connected

DOffline Activation

to the Intemet.
=] Choose this aption if you have a license server
E« Sl e 1ather than an activation code.

@ PR el Muodify connection settings if you are having
e problems connecting to the Intemet,

Help Back

Attéls Nr. 4: alternativo aktivizacijas iespéju logs.

Alternative activation options loga ir pieejamas vairakas funkcijas:

e Connection Settings: interneta savienojuma parbaudes un starpniekservera (proxy) konfiguracijas

funkcija, kas var bit noderiga, veicot tieSsaistes aktivizaciju.

e Use a License Server: funkcija papildu licenéu veidam — tikla licencém. Ar So funkciju var

konfiguret piekluvi lokalam tikla licen¢u
serverim.

e Offline Activation : programmas bezsaistes
aktivizacijas funkcija.

ir nepiecieSams aktivizacijas sertifikats. Lai to
generétu, jaievada aktivizacijas kodu lauka Activation
code, janokopé ieglto Installation ID kodu un timeklt
jadodas uz SDL profila sadalu Products & Plans >
Licensing. Aktivizéjamai licencei bls pieejama $ada

iespéja:
Pel H Can't activate online? — Get an

offline Activation Certificate

Lai generétu aktivizacijas sertifikatu, noklikskiniet uz
Sis iespéjas, ieglto Installation ID kodu iekopéjiet SDL
profila attiecigaja ratina (skat. Attéls Nr. 7) un péc
tam klikskiniet uz pogas Generate Offline Activation
Certificate. Tiks generéts vajadzigais sertifikats.

Product Activation

Offline Activation
‘& Allows you to activate the praduct without requiring an Interet connection.

Enter pour activation code below to generate the installation ID. Go to S0L Account and
enter the installation I to obtain your offine activation certificate.

Activation code: || _EEJ .

Installation 1D I EI

Activation certificate: =

7 Aclivate

Purchase a license  Altemative activation options

Help Cancel

Attéls Nr. 6: Trados Studio bezsaistes aktivizacijas logs.

Use copy and paste to avoid any typing errors.

Description: SDL Trados Studio 2015
Installation ID*:
Quantity*

Activation Code: 1234-activation-code-5678

To activate your software offline, please provide the Installation ID. This is shown in your software when you choose to activate offline.

Generate Offline Activation Certificate

Attéls Nr. 7: SDL profila bezsaistes aktivizacijas sadala.



Péc tam ar ieglto sertifikatu var aktivizét
programmu, ievadot to loga Offline Activation lauka
Activation certificate (skat. Attéls Nr. 6).

Kad programma ir aktivizéta, aktivizacijas
loga bis noradits aktivas licences veids. Saja loga ir

iespejams aplukot aktivizétas licences kodu,
izmantojot funkciju Show activation code.
Ar pogu Deactivate ir iespéjams deaktivizét

programmu tieSsaistes reZima, savukart bezsaistes
dezaktivacijai ir paredzéta poga Deactivate offline.

bezsaisté ir nepiecieSams
autorizacijas kods, kuru var iegit, SDL profila sadala

Products & Plans > Licensing. Saja
sadala izmantojiet attiecigajai licencei
pieejamo opciju Can't deactivate

&

Product Activation

SDL Trados Studio 2015 Product Activation
Wiew and manage your SDL Trados Studio 2015 license.

Active License:
SDL Trados Studio 2015 Professional

P Deactivate
T

SDL Account  Show sctivation code  Deactivate offine

Help | Continue

Attéls Nr. 8: produkta aktivizacijas logs ar aktivizétu licenci

Product Activation

Offline Deachivation
Deactivate the product without an Intemet connection,

online? — Deactivate offline, lai iegltu
autorizacijas kodu.

. e = e —Step 1
levadiet autorizacijas kodu programmas

SDL Trados Studio loga lauka
Deactivation authorization (skat. Attéls
Nr. 9).

lirk. to ol

Deactiv.

Péc tam bls aktiva iespéja generét
deaktivizacijas sertifikatu jeb Generate
Certificate, kas apstiprinas licences

Generate a deactivation certificate then enter it in the Account area of the SDL wehsite,

Log inta your SOL Account, access the Licenses area and follow the offline deactivation

Deactivation certificate:

B d Hi

te a certificate

btain a deactivation authorization for your license.

MORmMmEzH 2B mAHEABAAAAAFpAAgpidmhBczdHEABARS [T |
AAFRAAILDEY dwegnfh==

i

ation authorization:

L _9_| Generate Certificate

ool WADAEAAAADAIACG MANjgdMDlwdwA EAAAAFADAE S
oxTk100a3Uo35lo40 TUABDAEFORCmkgABAASAARIAL
REYThhND g0 COIMGYELT Q2N GIET drab S T 0 GYiMjo

deaktivizaciju. lekopéjiet iegltu
sertifikacijas kodu no lauka Deactivation
certification attiecigaja lauka SDL profila
un nospiediet  Confirm Offline
Deactivation (skat. Attéls Nr. 10).

IMPOR

oL L

shill be i

—Step 2: Return the certificate to SDL A

Save the deactivation certificate for this purpoze. If you do not retain and retumn the certificate to
pour SDL Account wou will not be able to generate a new activation cerificate as the licenze wil

TANT: Thiz deactivation certificate iz proof that you have deactivated wour licenze and
2t return it to wour SOL Account before the license can be used on another computer.

[gRPE-R

v | have returned the deactivation certificate to SDL

Péc tam programma SDL Trados Studio
apstipriniet  deaktivizaciju, atziméjot

Help | Canfirm |

ratinu | have returned the deactivation
certificate to SDL un nospieZot

Attéls Nr. 9: Trados Studio bezsaistes deaktivizacijas logs.

pogu Confirm (skat. Attéls Nr. 9).

Activation Date:

Lai deaktivizétu licenci
gadijuma, kad lietotaja
dators nedarbojas,
vérsieties pie SDL tehniska
atbalsta vai K Solutions.

Unigue Activation ID:

Activation State:

For help with deactivating your license, please view the SDL Licensing Help.

Deactivation Authorization:

deaclivation authorization code
01-06-2017

1234-unique-activation-id-number-5678 Deactivation Certificate:

Deactivation Initiated

Confirm Offline Deactivation

Attéls Nr. 10: SDL profila bezsaistes deaktivizacijas sadala.




1.4. TULKOSANAS ATMINU IZVEIDE UN PARVALDIBA

SDL Trados Studio failbazétu tulkoSanas atminu var izveidot ar attiecigu vedni, kuru var atveért:

1% Batch Edit s Upg

e sadala Translation Memories. Sis sadalas ﬂ E' ? g
) ) - =* % BatchDelste | (0D lig

rikjosla klikskiniet uz New > New Translation | o .0 pew  Import Export

Memory o - E Settings ﬁ Cre
g Mew Translation Memory Alb+ShiFE+
S € g Mew Server-based Translation Mermory

| {if Mew Language Resource Template

Tranzlation Memory and Automated Tranzlation
e attieciga projekta iestatijumos atverot sadalu

Language Pairs > All Language Pairs >
Translation Memory and Automated
Translation. Saja sadala noklikdkiniet uz

Select translation memory and automated tranzlation servers by
ﬂ zpecify whether o inchude them in lookup, concordance zean

o= pdd - |ofs Create - ||§‘Settings... | ¥ | Remaove

Mew File-based Translation Memaory, ..

Create > New File-based Translation Memory.  |Name
E?..TMS_K Mew Server-based Translation Memarsy, ..
B ThS_Spredumi "

Attéls Nr. 11: jaunas atminas izveidoSanas funkcijas sadala
Translation Memories (aug$sa) un projekta iestatijumos

(apaksa).
TULKOSANAS ATMINAS IZVEIDES VEDNIS
Atverot tulko3anas atminu  izveides
vedni, paradas attéla pa labi redzamais General
|OgS. Tajé ir pieejamas télék apraksﬁtés Specify name, location, source language and target language for this translation memary. E‘
funkcijas un lauki.
X Create From: I Browse... |v
e Name : atminas nosaukums. Mo - VER
v . Description: -
Tulko$anas atminas SRR 2l
nosaukuma nedrikst izmantot: =
- burtus ar garumzimém un Coppright: |
mlkitmajuma Zimem, Lacatior: |D:t_Proiectsheramples Brovise. . |
- punktus.
p Source Language: IE Latvian [Latvia] j
Target Language: IE Russian [Fussia) j
e Source Language: Originélvaloda_ [™ Enable character-based concordance search
e Target Language: tulkojuma valoda.
e Location: tulko3anas atminas faila
atraéanas Vieté. NOkIUSéjuma Help | < Back | Mext > I Finizh Cancel
tulkoSanas atminu mape ir:

Attéls Nr. 12: tulkoSanas atminas izveides vednis.

%userprofile%\Documents\Studio 2015\Translation Memories

Description, Copyright: papildu informacijas lauki.

Create From: §1 funkcija lauj parnemt informacijas laukus un segmentacijas iestatijumus no citas
failbazétas (Browse >File-based Translation Memory) vai serverbazétas (Browse >Server-based
Translation Memory) tulkosanas atminas.

Enable character-based concordance search: ja -

ieslégsiet 30 opciju, tulkosanas atmina indeksés ne tikai Saja vedna soli nospiezot pogu Finish,
veselus vardus, bet art vardu dalas. Tas var palielinat ::rrﬁilg:grs;gﬁf;iaa Eggég'fi?grar\ﬁem.
atrasto daléjo sakritibu skaitu, bet ietekmés atminas

atrdarbibu. Tade] liela apjoma atminam ir ieteicams

neizmantot So funkciju. Jau izveidotam atminam 3o opciju nevar mainit, bet ir iespéjams eksportét
atminas saturu cita atmina, kurai $1 opcija ir iesleégta/izslégta.



Klikskiniet uz pogas Next, lai pielagotu atminas papildu iestatijumus.

Klikskiniet uz pogas Finish, lai pabeigtu tulkoSanas atminas izveidi ar standarta iestatijjumiem.

FIELDS AND SETTINGS - INFORMACIJAS LAUKI UN ATMINAS IESTATIJUMI

Nakamaja vedna soli var definét tulkoSanas atminas papildu laukus. Visam tulko$anas atminam ir
sistémas lauki, péc kuriem var noteikt, pieméram, segmenta autoru, izveides laiku un to, cik reizes segments
ir izmantots ka pilniga vai daléja segmenta sakritiba.

FeldValis
] . Custom Fields
Fields and Settings )
Specify figlds and settings for this translation memary, E‘ Field Walue
Quality [91
SaourceFile Drmitrijews_KPL_Dmitri)...
— Fields TargetFile Crmitrijesz_EPL_Dritri)...
MHame Type Ficklist Allow kultiple Yalues Add
S priedurs | Systern Fields
Bemove
Field Walue
Created by TShdkabanova
R . Created on 1723420015 94319 AM
ecognize
Document struchure
v Diates v Acronyns v Alphanureric strings Last modified by TSt dkabanava
W' Times W Variables Last modified on 1/23/2015 35333 AM
W Mumbers ¥ Measurements Lazt uzed by T5hdkabanowa
Lazt uzed on 35,2015 10:34:20 Ak
r— Count as one if words: Usage count 1
I Are hyphenated I™ Contain formatting tags Attéls Nr. 13: informacijas lauki.
IV e joined by dashes ¥ Contain apostrophes
Tulkosanas  atminas  papildu
iestatljumi $aja sadala:
Help | < Back | Mest » I Finizh | Cancel |
Recognize: iestatijumi atsevisku
Attéls Nr. 14: tulkosanas atminas izveides vedna 2. solis. netulkojamu elementu veidu atpaziSanai. Nokluséjuma

iestatijumos visi elementi ir atziméti.

Count as one if words: iestatljumi vardu skaita aprékinam. Atkariba no izvélétajiem iestatijumiem vardi ar
domuzimém, svitram, apostrofiem tiks/netiks skaititi ka viens vards.

Klikskiniet uz pogas Next, lai dotos uz nakamo vedna soli.

LANGUAGE RESOURCES - ABREVIATURU ATPAZISANAS UN TEIKUMU SEGMENTACIJAS
IESTATIJUMI

Trados Studio piedava nokluséjuma iestatijumus segmentacijai, ka ari abreviatlru un kartas
numuriem sekojosu vardu sarakstus. Saja vedna soll ir iespéjams papildinat vai mainit $os iestatijumus. Loga
Language Resources lauka Resources atrodams saraksts ar talak aprakstitajiem resursiem.

> Variable List

Netulkojamo vardu saraksts, kurus programma vienmér atpazis ka netulkojamus elementus, piem.
iestazu, uznémumu vai zimolu nosaukumi.

> Abbreviation List

Abreviatiiru saraksts, kuru segmentacijas filtrs ignorés. Saja saraksta pievienotas abreviatiras, kas beidzas
ar punktuacijas zZimi, netiks uztvertas ka segmenta dalitajs, piem. “gab.”, “utt.”, “dzim.”
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> Ordinal Follower List

Saraksts ar vardiem, kas

Language Resources

para sti seko kartas Select a language resource template or specify the language resources for this translation memory. E‘
numuriem.  Punkts starp
kartas numuru un definétiem Template: INone | Browse. |
vardiem netiks uztverts ka e
. . . ettings
segmenta dalitajs. Piemeéri: o
“ ” " e eemp Diescription: ;I
21. panta”, 1. janija”, =
“2005. gada”.
. Language: |= Labvian [Latvia) -
> Segmentation Rules =l
- .. . - . Resources:  Type Edit |
Segmentacijas lestatijumi. L
. s = . i Wariable List
i : Feset
Tas ir pielagojams rakstzimju pir— Ese |
un koda elementu saraksts, Ordival Eollowar List
kur$ nosaka, ka programmai Segmentation Rules
dalit tekstu segmentos. Ar | |

nokluséjuma iestatijumiem

rogramma dala segmentu
p_ & & Help | < Back | Hext > | Finizh I Cancel |

péc katra punkta, kola,

jautajuma vai  izsaukuma Attéls Nr. 15: tulkosanas atminas izveides vedna 3. solis.

zimes. Segmentation Rules E

Ar grafiskas saskarnes palidzibu vai Regular ¢ pasgaphbased ssgmentation
Expression kodiem ir iespéjams mainTt esoSus vai & iSsnerce based seqmeniaion
noteikt jaunus segmentacijas iestatijumus. |-.-..m|p —
Darbam ar Microsoft Ofﬂce dokumentiem gos Other terminating punctuation [question mark, exclamation mark]

Calan Edi |
. - .= . it...
lestatijumus nav jamaina.
Remove |

Segmentacijas iestatijjumu iznémumus Reset to Defauls |
var konfigurét, mainot paréjo Seit
pieejamo resursu iestatijumus.

Lai Fonflguretu kadu no. rve§u'r5|em, atlasiet t.o o
saraksta Resources un noklikskiniet uz pogas Edit
(skat. Attéls Nr. 15)

Cancel | Help

Attéls Nr. 16: segmentacijas iestatijumu logs.

TULKOSANAS ATMINAS SATURA FILTRI

Programmas Trados Studio sadala Translation Memories ir iespéjams atvért tulkoSanas atminas un
filtrét to saturu.

Search Detail:

TH Filter: IFilter: date, nok T34 dkabanova® j YT Y B R
Filker M ame IFiIter: date, not TSdkabanowva NOT Canditian AND/OR
Source Text | Created on > "3/1/2007 12:45 39 AM" AMND
Created by CONTAINS “dkabanowva"
Target Text I
Search Type I Search entire TH j

& Perform Search | I Case sensive ™ Use parentheses in this Fiter Add... Inzert... Edit... Delete
_ ¥ Use wildeards 7]

Attéls Nr. 17: tulkoSanas atminas satura filtri sadala Translation Memories.

Ar filtru, sistémas lauku un citu informacijas lauku palidzibu ir iespéjams atfiltrét segmentus péc
vairakiem kritérijiem, pieméram, atfiltrét viena lietotaja tulkojumus, kuri tika izveidoti péc noteikta datuma.

Ar pogu T var izveidot jaunu filtru un ar pogu T tovar saglabat turpmakai lietosanai.

Loga labaja pusé (skat. Attéls Nr. 18) ir redzami filtra nosacijumi, kurus var pievienot, mainit vai
dzést, izmantojot attiecigas pogas Add, Edit un Delete. Noklikskinot uz pogas Add, tiek atveérts filtra
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nosacijumu izvéles logs ar diviem nolaizamajiem sarakstiem, [ Add Condition 3]
kuros var izvéléties filtréSanai izmantojamos informacijas
laukus un filtra operatoru, ka ari ievadit filtréjamo vértibu. Field: [ Last modfied on x|
. v. . L . Operator: 1 -
Papildus $im filtram SDL Trados Studio ir pieejamas perstor: |Equalto l
mekléSanas un aizvietosanas funkcijas (Find, Replace), ar LT
kuram var apstradat atfiltréto segmentu saturu. 5/ 3/2017 35524 B~
Sadala Translation Memories veiktas izmainas oK ] [ Cancel l [ Help l
tulkoSanas atminas segmentos netiek uzreiz saglabatas. Tas ir |
papildus jaapstiprina, izmantojot funkciju - Ei:l Attéls Nr. 18: filtra nosacijumu izvéles logs.
Carmmik
Changes
Papildus tai ir pieejamas ari $adas funkcijas: Sadala Translation Memories
= Discard . veiktas izmainas tulkoSanas
(% Discard TU Changes __ atcelt tulkojuma vieniba (segmenta) atminas segmentos ir
veiktas izmainas; papildus jaapstiprina, .
) izmantojot funkciju Commit
(% MarkTUfor Deletion __ 5t7imét tulkojuma vientbu (segmentu) ka | Changes.

dzésamu. Segments tiks dzeésts, tiklidz nospiedisiet Commit Changes.

Ar mekléSanas un aizvietoSanas funkciju ir iespéjams vienlaikus veikt tikai Iidz 100 izmainam. Lielaka
skaita izmainu veikSanai var izmantot funkcijas Batch Edit un Batch Delete.

L% BatchDelete _ patch Delete dzés visus segmentus, kas atbilst definétajam filtram.

L% BatchEdt  __ Baich Edit veic noraditas izmainas visos segmentiem, kas atbilst definétajam filtram.

Sis funkcijas ir Tpadi noderigas masveida izmainam, pieméram, ja tulko$anas atminas ir nepiecie$ams aizvietot
nepareizi izmantotu vai novecojusu terminu.

Batch Edit
Batch Edit Scnpt
Specify a batch edit script to be applied to the Th. {L,"
Filter: [ Filter. Edited = Mo =l
Continuation: I.&Iways gxecute all edit actions in the list for each TU ﬂ
Actions:
Action D etailz Add
Find and Replace Text I target, replace ‘incaorrect_term' with 'correct_term'’ Edit |
Change Field % alue Edited, Replace, value =Yes
Delete |
Delete Al |
Move p |
Fed o e |
Load... | Save...

Help | < Back [ext = Finizh | Cancel |

Attéls Nr. 19: funkcijas Batch Edit logs.

Funkcijas Batch Edit loga izvélné Filter ir iespéjams noradit kadu no ieprieks izveidotiem un
saglabatiem filtriem. Tas tiks izmantots, lai atfiltrétu redigéjamus vai dzésamus segmentus.
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Izvélné Continuation ir pieejamas divas opcijas:

e Always execute all edit actions in the list for each TU — katra segmenta veikt visas noraditas
izmainas.
e Only allow one edit action to change each TU — katra segmenta veikt vienu no noraditajam
izmainam.
Prioritari tiks veiktas izmainas, kas ir saraksta Actions augsa. Saja saraksta tiks paraditi visi ar pogu Add
pievienotie izmainu noteikumi. Atlasitas darbibas vietu saraksta var mainit ar pogam Move Up un Move
Down.

IMPORTESANA, EKSPORTESANA, DATU APMAINAS FORMATI

TulkoSanas vienibas (segmentus) no tulkoSanas atminam var importét un eksportét ar attiecigajam
funkcijam Import un Export. Sis funkcijas ir pieejamas sadalas Translation Memories rikjosla, ka ari projekta

lestatijumu tulkosanas atminu sadala.
Datu eksporta un importa formats ir Export Options
tmx kas ir standartizéts forméts datu Specify export optionz and click Nest to start exporting. ?—)
. )
apmainai starp SDL Trados Studio failbazétam -
- == v — - — wpark ta:
un serverbazétam tulkoSanas atminam, ka ar | ; |
[QWZE, ..

citu tulkosanas programmu tulkoSanas -

atminam. |inane) Edit... |

Eksportéjot datus no tulkosanas atminas’ ir ™ Export ta Warkbench-optimized T3, farmat for use in Trados 2007
pieejamas Sadas iespéjas:

e Export to—  eksportéjama faila

nosaukums un atrasanas vieta.
. . . - . . . Help ¢ Back [dERt Finizh I Cancel
e Filter — filtra iestatijumi, ar kuriem ir |

iespéjams noteikt, kadi segmenti tiks
eksportéti. Ja atstasiet So lauku tuksu,
tiks eksportéti visi tulkoSanas atmina pieejamie segmenti.

e Export to Workbench-optimized TMX format for use in Trados 2007 — funkcija, kura Jauj eksportét
atminas saturu Trados 2007 atbalstita formata.

Attéls Nr. 20: eksportesans funkcijas logs.

Datu importésana tulkosanas atmina notiek
Iid ZTgI Import Files
Select the filez pou want ta import inta the tranzglation mamory. ?(_

Pirmaja soll (Import Files), izmantojot
funkciju Add Files vai Add Folders, japievieno Files:

importéjamu(s) failu(s). Ar pogu Remove failus | AddFies.. |
var iznemt no importéjamo failu saraksta. Add Folder... |

Femave |

Tulkojumu var importét art
no .sdIxliff formata failiem.

Talakajos vedna solos ir iespéjams konfigurét iz | Bk Wez® Fitizh L]
papildus iestatijumus. Ja standarta iestatijumi
nav jamaina, tad failu importésanas procesu var
sakt jau $aja soli, noklikskinot uz pogas Finish.

Attéls Nr. 21: datu importésanas tulkosanas atmina logs.

Nakamaja solt TMX Import Options (skat. Attéls Nr. 22) var konfigurét importésanas filtru, kas ir identisks
eksportésanas filtram un piedava iespéju atfiltrét importéjamos segmentus péc noteiktiem kritérijiem.
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Funkcija Unknown Fields piedava iespéju
ignorét segmentu papildu laukus (lgnore),
neimportét segmentus ar neatpazitiem
papildu laukiem (Skip translation unit),
partraukt importésanas procesu (Fail
translation unit import) vai pievienot
papildu laukus  atminai kopa ar
importéjamiem segmentiem (Add to
translation memory).

Nakamais un pédéjais vedna solis
(General Import Options) |auj noteikt, ka
tiks apstradati importéjamie segmenti. Ir
pieejamas Sadas iespéjas:

e Apply Field Values —

pievienot

Imporkt E

THMX Import Options
e

Filter:

Specify import options for the T files pou have selected.
Edi... |

I[none]

Unknown Fields: IAdd to tranzlation memory j

Fleaze zelect the scenario that applies best to pou:

o The imported data will be primarily used with new, native source files or files processed only with SDL Trados
Studio

" The imported data will be primarily used with presegmented legacy SDL Trados ITD or TTX files

" The imported data will be primarily uzed in mixed scenarios

Help | < Back | Mext > I Firish Cancel

Attéls Nr. 22: importésanas iestatijumi.

informaciju papildlaukos. Ja tulkoSanas atminai, kura gatavojaties importét datus, ir iestatiti pielagotie
lauki (Custom fields), Seit varat noradit, kadas vértibas pieskirt Siem laukiem.

e Import translation units as
formateéjuma/tagiem.

plain text —

importét segmentus ka vienkarSu tekstu bez

Exclude language variants — neimportét segmentu, ja ta valodas dialekts nesakrit ar tulkoSanas
atminas valodas dialektu. Piemérs: tulkoSanas atmina ar valodu kombinaciju EN-GB > LV-LV netiks
importéti segmenti ar valodu kombinaciju EN-US > LV-LV.

Export invalid translation units — neimportétie segmenti tiks apkopoti atseviska .tmx faila, kura

nosaukums un saglabasanas vieta janorada lauka Export location lauka.

Ar opcijam lauka If target segments differ
(skat. Attéls Nr. 23) var noteikt, ka
programma  rikosies ar  tulkojuma
vientbam, ja tam sakrit originalvalodas
segmentu teksts, bet atskiras tulkojums. Ir
pieejamas Sadas iespéjas:

e Add new translation units —
pievienot ka jaunu tulkoSanas
vientbu. Tulkotajiem bis pieejams
gan vecais, atmina eso$ais, gan
jaunais, importétais variants.

e Overwrite existing translation
units — aizstat tulkoSanas atmina
esoso tulkojumu ar importéto.

e lLeave existing translation
unchanged — nemainit
esosos tulkojumus.

e Keep most recent translation units —

units
atmina

Import E

General Import Options
Specify general import options and click Finish ta start importing.

e

Exdit.... |

Apply Field ' alues:

Il Import tranzlation units as plain text
[T Exclude language variants

Il Export invalid tranzlation units

Export Locatior: Browsze.. |
If karget segments differ:
% Add new translation units
' Ovenwrite existing translation units
" Leave existing translation units unchanged
" Keep most recent translation units
¥ Use infarmation from bilingual file ko update TU system fields
Help | < Back | [dext > | Finish I Cancel

‘Attéls Nr. 23: importésanas papildu iespéjas.

atstat jaunako tulkojumu. Saja gadijuma tiks salidzinati divu tulkojuma vienibu pédéjo izmainu datumi,

lai noteiktu, kura no tam ir jaunaka.

Izvéles rutina Use information from bilingual file to update TU system fields nosaka, vai izmantot
informaciju no importéjamiem .tmx failiem, lai atjaunotu tulkoSanas vienibu sistémas laukus (t.i. autors,

izmainu veikSanas laiks).
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1.5. FAILBAZETAS TERMINOLOGIJAS DATU BAZES IZVEIDE UN PARVALDIBA

Failbazétu terminologijas datu bazi (TB) ir iespéjams izveidot ar attiecigu vedni, kuru var palaist:

e programma MultiTerm Desktop, atverot File > New > Create Termbase;

e programma Trados Studio, projekta iestatijumos: Project Settings > All Language Pairs >
Termbases > Create > New File-based Termbase.

Programma MultiTerm veidotu datu bazu saglabasanas nokluséjuma mape ir:
%userprofile%\Documents\SDL\SDL MultiTerm\Termbases
Programma Trados Studio veidotu datu bazu saglabasanas nokluséjuma mape ir:

%userprofile%\Documents\Studio 2015\Termbases

TB struktiras piemérs: Atskirtba no failbazétam tulkoSanas atminam terminologijas datu
bazu dati glabajas vairakos failos. Parvietojot terminologijas datu bazi
(TB) no vienas mapes uz citu, jaiegaumé, ka katra termbaze sastav no
vairakiem failiem (skat. pieméru kreisaja pusé): viena .sdltb faila un pa

vienam .mdf un .mtf failam katrai terminologijas datu bazé ieklautajai
L;I example_TB-Latwvian.mdf valodai.

|| example_TB-Latvian.rmtf

u example_TB.sditb
L;,j excample_TE-English, mdf

|| exarnple_TB-English,mtf

TERMINOLOGIJAS DATU BAZES IZVEIDES VEDNIS

Veidna pirmaja_soli (Termbase Definition) ir iespéjams izvéléties avotu, no kura parnemt
terminologijas datubazes iestatijumus — valodas, papildu laukus un datu bazes struktlru. Ir iespéjams ari
veidot pilnigi jaunu datu bazes struktaru.

Termbase Wizard - Step 1 of 5
Termbase Definition

Specify whether pou wish to create a termbase definition using one of the predefined termbaze templates, load
an exigting termbase definition or create a new termbaze definition from soratch.

% Create a new termbase definition from scratch

£ lsge a predefined termbase template

Bilingual glozzan j

£ Load an existing termbase definition file

| Browse. .. |

= Lse an existing termbase as a template

SDL ‘ MultiTerm | Brovise... |

I™ Copycatalog abjects to the nev termbase

¢ Back | MHest > I Cancel Help

Attéls Nr. 24: terminologijas datu bazes izveides vedna 1. solis.
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Izvélei ir pieejamas Sadas opcijas:

e Create a new termbase definition from scratch: izveidot jaunu terminologijas datu bazes struktdru.
e Use a predefined termbase template: izveidot terminologijas datu bazi no ieprieks definéta parauga.

Saja izvélné ir pieejami programma ieklautie $abloni.

e Load an existing termbase definition file: izveidot terminologijas datu bazi no $ablona. Sadus $ablonus
var iegit, eksportéjot tos no failbazétam un serverabazétam terminologijas datu bazém.

e Use an existing termbase as a template: izveidot terminologijas datu bazi, nemot par paraugu citu
failbazétu terminologijas datu bazi. No parauga datu bazes tiks parnemta tikai tas struktlra, bet ne

termini.

Vedna otraja soli (Termbase Name) terminologijas datu bazei japieskir nosaukums, ka art vajadzibas
gadijuma var aizpildit papildus informacijas laukus.
Friendly Name: terminologijas datu bazes nosaukums, kur$ tiks attélots

programmu Trados Studio un MultiTerm datu bazu sarakstos.

Vedna treSaja_soli (Language Fields) terminologijas datu bazei
japievieno vajadzigas valodas. AtSkiriba no tulkoSanas atminam terminologijas datu bazés var bt ari vairak

par divam valodam.

Nosaukuma lauks
(Friendly Name) ir
jaaizpilda obligati.

Vedna ceturtaja soli (Descriptive Fields) ir iespéjams definét un konfigurét papildu informacijas
laukus. Tie var saturét dazdda veida informaciju par terminiem. Sos laukus vedna piektaja soli (Entry

Structure) bis iespéjams pievienot
vienam no trim terminologijas
datubazes struktlras limeniem
(skat. Attéls Nr. 27).

Lai definétu jaunu informacijas
lauku, vispirms kreisaja pusé lauka
Field label (skat. attélu pa labi)
jaieraksta lauka nosaukums (piem.
,Definicija”) un ar pogu Add

Termbase Wizard - Step 4 of 5 E

Descriptive Fields
Create descriptive fields far your termbase entries. Use the Properties dialog box to specify the tppe of data each field may contain. The default data type

far all fields is text

Field Iabel

Description [optional]:

Add>s |
<< Remave: |

Descriptive fields:

Subject

Mote

Source

Status

Dréfinition

Context
Grammatical Gender
Grammatical Mumber
Part of Speech
Category

Usage Register

japievieno sarakstam Descriptive
fields labaja pusé. Péc tam, atlasot
saraksta  vajadzigo lauku un
nospiezot pogu Properties, var
noradit lauka/informacijas veidu
(piem. teksts, nolaizamais saraksts,
attéls).

Praperties.
< Back | Next » I Cancel | Help |

Attéls Nr. 25: terminologijas datu bazes izveides vedna 4. solis

Propetties - Status

Vedna piektaja soli (Entry Structure) var pievienot definétos %FK .

. . R - . —1= o e ickliz A b
papildu informacijas laukus kadam no trim talak aprakstitajiem el SRy
terminologijas datu bazes struktiras limeniem. Pickiist + (%1 ]

prefemed
admitted
rejected

e Entry level — ieraksta [imenis. Sim limenim ir piesaistita tikai

sistémas informacija (piem. ieraksta numurs, izveides datums).

o Index level — valodas limenis.

= Term level — termina limenis. Katrai valodai var bat [ ok | cacad | Hep |
pievienoti vairaki termini.

Attéls Nr. 26: papildu lauka iestatijumi.
Katra no Siem limeniem var pievienot ieprieks definétos laukus. Piemeéra (skat. Attéls Nr. 27) loga
kreisaja pusé ir redzama paplasinata datu bazes struktira. Taja redzams, ka valodas liment ir pievienoti
definicijas lauks (Definition) un piezimju lauks (Note), savukart termina [imen ir pievienoti vairaki lauki (Note,
Context, Source, Category utt.), ka ari statusa lauks (Status), kuram ceturtaja soli tika konfiguréti dazi
parametri (skat. Attéls Nr. 26). Proti, Sim laukam ir izvéléts nolaizama saraksta formats (Picklist), un $aja
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saraksta ir definéti vairaki
iespéjamie termina statusi. Ar
sadu konfiguraciju ir iespéjams

Termbase Wizard - Step 5 of 5 [x]

E ntry Structure

Create an enty stiucture far your termbase entries by specifying the level at which descriptive fields are used. Specify field settings if required

katram terminam noradit ta EEW;‘
aktualitati. S b Indes leve
o Tem level
. . _ . Mate
Piektaja soli ar Field gontext
settings iestatijumiem ir Status

iespejams pieskirt laukiem divas
papildu kategorijas: Mandatory

(2] Grammatical Gender

Grammatical Humber
Part of Speech
Categomy

Uszage Register

(obligati aizpildams lauks [5] Delinition
. - . - - . Maote

attiecigaja lImeni), Multiple hm

(attiecigaja lTmeni var pievienot e

vairakus $ada veida laukus).

Awailable descriptive fields:

Categomy

Context

Definition
Grammatical Gender
Grammatical Number

Note
Part of Speech
Source
Status
< add | Subject
Usage Register
Fiemoye »> |

Field settings:
¥ | iandatorny
¥ Multiple

< Back | Mext I

Cancel Help

Attéls Nr. 27: terminologijas datu bazes izveides vedna 5. solis.

TERMINOLOGIJAS DATU BAZES DEFINICIJAS SABLONS

Terminologijas datu bazes definicijas Sablonu
var saglabat, attiecigas datu bazes parvaldibas sadala
Termbase Management atlasot Definitions un péc tam
noklikskinot uz funkcijas Save (skat. attélu pa labi).

Edit

Catalog Actions

Termbase Mana... < | Defintion
Catalog Categonies o x
Languages
Latvian
E Input Models Russsian

[7, Export

3 Import

Attéls

Nr. 28: terminologijas datu bazes S$ablona

saglabasana.

TERMINOLOGIJAS DATU BAZES SATURA IMPORTESANA UN EKSPORTESANA

Terminologijas datu bazu satura importésana un eksportésana ir iespéjama programma MultiTerm
Desktop. Abas funkcijas ir pieejamas programmas sadala Termbase Management.

Datu apmainai starp terminologijas datu
bazém tiek izmantoti .xml formata faili.

Importésanas vai eksportéSanas
procesu sak, izvéloties vienu no talak
aprakstitajiem importésanas vai
eksportésanas  procesu  veidiem un

noklikskinot uz Process (skat. Attéls Nr. 29).

Terminu importésanai ir sadi

procesu veidi:

pieejami

e Default import definition: nokluséjuma
terminu importésanas process. Tas
meégina importét visus terminus, un
procesa laika atmet/neimporté
terminus, kuriem ir attiecigaja

E

s O &

Activate Create Duplicate

Catalog Categories

Termbase Mana...

SDL MultiTerm - TB_Terminologija = B X
Add-Ins Help
L, o L ‘; =] [}, Delete Termbase
= ¢

¥ Reorganize
Load Save | Process

Catalog Actions Termbase Actions ~
< Import v X
1 x Name Active | Owner | pescription |
Detault import definition o Role Imports all e...

8 e el %
L3 Delinition
[Z] Layouts
Y Filers
E Input Models
&1 Import

¥, Export

E Terms

E:a Termbase Management

Synchronize on Ertry N... Add ertries ...

Add entries ..

System
System

Synchronize on Term

Add entries as new entries. However, if entries with the same term exist
already, then the entries are merged.

Attéls Nr. 29: importésanas procesi programma MultiTerm.
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terminologijas datubaze nedefinéti papildu informacijas lauki.

Synchronize on Term: importé un sinhronizé terminus atbilstosi sakrittbam terminu [imen1 (Term level).
Identiskie termini tiek apvienoti.

Synchronize on Entry Number: importé un sinhronizé datubazes terminus atbilstosi kartas numuram
ierakstu Iimeni (Entry level). So importa procesu ir ieteicams lietot, lai atjauninatu datubazes ar
jaunakam to kopijam.

Importésanas vedna pirmaja soli (General Settings) janorada importéjams .xml fails (Import file).

Zurnalfails (Log file), kura tiks ierakstita informacija par importa procesu, tiks saglabats ar faila paplasindgjumu

.log taja pasa mapé.

Import Wizard - Step 2 of 8 B

General Settings

Saja pasa soli var izvéléties
atras terminu importésanas
funkciju (Fast import), kas ir

Click Browse to select the import file (kL] and the import log file belov. |f pou wish to filker the contents of the import file, select a filker from the drop-down
list,

. . . . . Imnport file:
pleeJama tlkal tadl Ja 'Xml ID:\_Proiects\examples\TB exporthTE_T erminalogija_export. sml Browse. .. |
fails pilntba atbilst Logfie:
M ultiTerm XML im po rta ID:\_Proiects\examples\TB exportsTB_T erminclogiia_export. log Save Az |
formétam un nav ™ Fast import [impart file is fully compliant with MultT em kL)
eksportéts no CltaS ™ Peiform full rearganization after import
terminologijas parvaldibas I pply it
- e = e ISource containg synonyms j
sistémas, un reorganizacijas
funkciju (Perform  full
reorganization after [ ek |[ wews | cancel | Heb
import), kura palielinas

datu bazes darbibas atrumu.

Attéls Nr. 30: terminu importéSanas vedna 1. solis.

Otraja soli (Validation Settings) janorada fails, kura tiks apkopoti atfiltrétie vai citadu iemeslu dé]

importésanai nederigie termini (Exclusion file). Turklat $aja soll ir iespéjams pielagot vél citus importésanas
iestatijumus:

° Ignore Subla nguages . Specify an exclusion file for invalid [incomplete or over-complete] entries and decide how such entries should be processed during the impart.
ignorét valodas
dialektus (piem., lai Exclusion fle:
i m po rtétu term | nus no ID:\_F‘roiects\examples\TB exportscl.wel Save bs... |
datu bézes ar brltu ¥ Allow incomplate entries
a ng! u va |0daS datu ¥ Allow gvercomplete entries
bazes cita datu bazé ar ' Ignare sublanguages
amerikanu anglu
va IOd u ) ’ < Back | Mest » I Cancel Help

Allow incomplete entries: importét terminus, kuriem nav aizpildtti visi lauki.
Allow over-complete entries: importét terminus ar papildu laukiem, kas datu bazé nav definéti. Papildu

lauki tiks ignoreéti, bet
termini tiks importéti. validation Settings

Attéls Nr. 31: terminu importésanas vedna 2. solis.

Savukart terminu eksportésanai ir pieejamas vairakas funkcijas saderibai ar citu programmu un vecaku

programmu versiju formatiem. Batiskakie no tiem:

Default export definition: terminu eksportéSanas nokluséjuma process. Tas eksporté datus .xml
formata, ko var importét failbazétas un serverbazétas terminologijas datu bazés.

Tab-delimited export definition: eksportéSanas process, kas sakarto terminus atseviskas kolonnas ar
tabulatoru palidzibu. leglto .txt failu ir iesp&jams importét citas sistémas un SQL datu bazeés.
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Veicot eksportésanu, vedni ir janorada
eksporta faila nosaukums un saglabasanas
vieta lauka Export File. Zurnalfails (Log file)
tiks saglabats ar tadu pasSu nosaukumu un
taja pasa mape, tikai ar faila paplasinajumu
Jdog. Noklikskinot uz pogas Next, tiks sakts
eksportésanas process.

Export Wizard - Step 2 of 8

Export Settings

Select the export file and choose to sort termbase content by entry number or by language index. IF you wish to apply a filter during export, select one from
the drop-down list.

For a complete backup of your termbase, select Sort termbase content by entry number.

Export file:
ID:\_Fro\ects\examples\TE exporthTB_Teminologija_export xml Save b I
Log file:

[0:*_Projects\euamplestTE export\TB_Teminologie_esportlog Saveds...

% Sort termbase cantent by entry number

 Sort termbase content by language field

ISnurEE j
I Appy fter
ISUurCE containg synonyms j
<Back Mew> | Cancel Help

Attéls Nr. 32: terminu eksportésanas vednis.
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1.6.

AUTOSUGGEST VARDNICAS IZVEIDE

AutoSuggest vardnica ir tulkotajiem noderigs papildu resurss, kas tulkoSanas laika automatiski piedava
atpazitu vardu un frazu tulkojumus. Atskiriba no tulkoSanas atminam un terminologijas datu bazeém, Sim
resursam nav servera versijas — tas ir pieejams tikai lokali.

AutoSuggest vardnicu var izveidot tikai no lokalas tulkoSanas atminas,
kura ir ne mazak ka 10 000 segmenti. Tadé| tas izveidei ir ieteicams viena
tulkoSanas atmina apkopot no citam lokalam un servera tulkoSanas
atminam eksportétus tulkojumus (skat. ImportésSana, eksportésana, datu

apmainas formati 13. Ipp.).

AutoSuggest vardnicas izveides vedni var atvért ar funkciju Create AutoSuggest
Dictionary, kura atrodas Trados Studio sadalas Translation Memories cilné Home.

Vednim ir 4 talak aprakstitie soli.

Pirmaja _ soli janorada
lokala tulkoSanas atmina, no kuras
tiks veidota AutoSuggest vardnica.

Otraja___ soll  janorada
vardnicas originalvaloda un
tulkojuma valoda. Turklat ir
iespéjams noteikt filtru, lai netiktu
importéti nevajadzigi segmenti

(skat. Tulkosanas atminas satura
filtri 11. 1pp.)

TresSaja_soli var noradit

segmentu  skaitu, kur$  tiks
apstradats, lai izveidotu
AutoSuggest atminu. Pec

nokluséjuma un bez 1pasiem filtru
parametriem tiks apstradati visi
segmenti. Ja atmina ir parak liela,
un iegltais vardnicas fails
parslogo tulkotaja sistému, tad So
skaitu var samazinat.

atliek
vardnicas

Ceturtaja soli
noradit AutoSuggest
saglabasanas vietu.

Péc tam leglto AutoSuggest vardnicas .bpm failu var pievienot tulkoSanas projektiem

iestatljumu Sablonam.

AutoSuggest vardnicu
var izveidot no lokalas
tulkoSanas atminas,
kura ir vismaz 10 000
segmenti.

Create AukoSuggest
Dictionary

New AutoSuggest Dictionary

Select Translation Memory
Fleaze zelect a file-based tranzlation memary or T file from which to generate an AutoSuggest dictionanp.

= E3

Tranzlation memaorny:

Briowse .. |

I E3

New AutoSuggest Dictionary

AutoSuggest Dictionary Settings

Flease selects sowrce and target language for the AutoSuggest dictionary and optionally select a filker to limit
the content used to create the dictionary.

Source language: I= Labvian [Latvia) j
Target language: IE Ruszsian [Russia) j
Filter: I[none] Edit... |

New AutoSuggest Dictionary

AutoSuggest Dictionary Creation Memory Usage
Fleaze zelect the nurber of tranglation units that should be processed for creating the AutoSuggest dictionary.

If you experience out of memory problems when creating an AutoSuggest dictionary, pou can reduce the number of translation
unitz proceszed when creating the AutoSuggest dictionany. Lower values use less memary but may alzo result in fewer phrases
being available in the AutoSuggest dictionary, however thep cah help avoid out of memory issues.

Murnber of translation units o process: |301 41

Minimum tranglation units M aximurn brarislation units

[tranglation unit count)

)

Less phrazes ore phrases
Less memory ore memary
Less time ore time
Feset |

New AutoSuggest Dictionary !E

AutoSuggest Dictionary Location
Fleaze zelect a location for the AutoSuggest dictionary.

Browse ... |

AutoSuggest dictionary location: I

vai projektu
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1.7. TULKOSANAS PROJEKTI

SDL Trados Studio projekta ir apkopoti tulkojamie faili, tulkoSanas resursi un iestatijumi. Projekta
failu struktidra tiek lietoti divi specifiski failu formati:

.sdIxliff — bilingvals (divvalodu) tulkojuma fails. Saja faila glabajas segmentéts tulkojamais teksts un
ta tulkojums (ja tas ir ievadits un saglabats), bet nav informacijas par citiem projekta iestatijumiem.
Katrai projekta iestatitajai tulkojuma valodai tiek generéts atsevisSks divvalodu fails un saglabats
projekta mapes attiecigas valodas apakSmape.

.sdlproj — projekta iestatijumu fails. Sis fails satur informaciju par tadiem projekta iestatijumiem ka
izmantotajam lokalajam un servera tulkosanas atminam un terminologijas datubazém, AutoSuggest
vardnicam, kvalitates parbaudes iestatijumiem u. c.

JAUNA PROJEKTA IZVEIDE

Projekta izveides vedni var atvért, izmantojot funkciju New Project sadala Welcome vai sadalas
Projects cilné Home.

New Project !E[
Pirmaja soli (Project Type) Proiect Type
var iZVéléties' no ké pé rnemt Specify whether to create a project bazed on a project template or whether to create a project bazed on a -
‘ previous project.

projekta iestatijumus:

¥ Create a project based on a project template

Create a project based on a [Defeuit -] Browss |
project template — izveidot
projektu no iesta.ﬁjumu §ab|0na. " Create a project based on a previous project

|Muster Infarmationzblatt_DE . pdf v| Erowsze... |

Create a project based on a

previous Project — izveidot
projektu, balstoties uz iepriekigja | CEECER | | N W=
projekta iestatijumiem. Attéls Nr. 33: jauna projekta izveides vedna 1. solis.

leteicams izveidot Sablonu ar vajadzigajiem standarta projekta
iestatljumiem, lai atvieglotu tulkotajiem ikdienas darbu (skat.
Projekta iestatijumi un projektu iestatijumu Sabloni 25. lpp.)

L _ ) New Project M=
Otraja soli (Project - )
. .o — . Project Details
Detal/S) Ja norada proje kta Fleaze specify a project name and location, and optionally specify a project description, number, custamer and -
= due date.
nosaukums lauka Name un
saglabasanas  vieta lauka Mame:  [Project settingd
Location. Ir  pieejami arl Description: =]

informativie lauki, kas nav
jaaizpilda obligati, un funkcijas,

. - - . Location: ID:\_F'roiects\eHampIes\F’roiect zettings Browse... |
kuras Jauj noradit projekta

¥ &llow saurce editing

terminu (Due Date) un gala
klientu (Customer). Saja soli

[ Users assigned on a project package must run verification befare returning the package

atrodamas ar1 papildu funkcijas: I~ Publish preject on GroupShare

eAllow source editing — Server: | o smes. |
atlaut originalvalodas teksta Location:[(Nene) Bowse, |
redigésanu. leteicams $So About SDL GroupShare..
iespéju  neaktivizét, lai DueDate: I [[Grzivzm? 2 | B —]
tulkotajs nevarétu mainit Customer: | <none> <] Customers. |
originalvalodas  segmentu
saturu. Attéls Nr. 34: jauna projekta izveides vedna 2. solis.
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e Users assigned on a project package must run verification before returning the package — lietotajam,
kuram tika pieskirta projekta paka, pirms pakas nodoSanas ir obligati japalaiz tulkojuma parbaudes
funkcija. So funkciju parsvara izmanto tikai projektu vaditaji, kuri izsita tulkotajiem projektu pakas.

e Publish project on GroupShare — publicét projektu GroupShare serveri, kur tas bls pieejams citiem
lietotajiem. Si funkcija netiks plagak apliikota, jo Tiesu administracijas serveri ta nav pieejama.

Tresaja_soli (Project Languages) [ammrmemme M=
janorada projekta originalvaloda Project Languages
(SOUrC@ Language) un tu | kOj uma Select a project source language and 1 or more project target languages. -
valoda(s) (Target Languages).
. _ A A — Source Language
Projektam var bat tikai viena = =]
originalvaloda, bet vairakas
. T arget Languages
tulkOJUma VaIOdas' Available: Selected:
an Afar [Diibouti] ﬂ Englizh [United Kingdom)
A4, i:ar {Eri:.ea.] ] E germ.an [[E‘ermfar]w]
AL ar [Ethiopia uszian [Russia
AF  Afrikaans [Mamibia)
Afrikaans [South Africa)
£33 Aghem [Cameroon)
AK Akan (Ghana)
Bl #lbanian [&lbania] ;I
Help | < Back I Mest » Firizh Cancel
‘Attéls Nr. 35: jauna projekta izveides vedna 3. solis.
Ceturtalé SOIT (PI’OJECt Flles) New Project !EE
japievieno tulkojamie faili, izmantojot Project Files
M . Add project files or folders and werify that all file types are correctly identified.
funkciju Add Files, ar kuru var L
pIeVIenOt ML L V?Irak‘us ‘fallus" Val Bﬂdd Files... . Add Folder... Iew Folder... | Merge Files. .. | Change File Usage... | -
Add Folder, ar kuru tiks pievienoti visi = BT [ . | 5 | ; | ; S
noraditaja mapju struktira atrastie e G == = e
IE_I] sampleda. 31 KB Microsoft.. Translatable WwWord 2000-200...

tulkojamie faili.

Lai turpinatu projekta
izveidi, ir jablt

Tranglatable: 1 Reference: 0

pievienotam vismaz e
vienam tulkojamam |

< Back I Mext > I Finizh Cancel

failam. Projekta izveides
laika tas nedrikst bat
atvérts cita programma.

Attéls Nr. 36: jauna projekta izveides vedna 4. solis.

Piektaja soli (Trasnlation Memory and Automated Translation) projektam var pievienot lokalas un
servera tulkoSanas atminas, izmantojot attiecigas funkcijas Add > File-based Translation Memory un Add >

Server-based Translation Memory.
Failu segmentacijas iestatijumi tiek parnemti no prioritaras atminas,
t.i. no atminas, kas saraksta atrodas visaugstak.

Pievienotajam atminam ir pieejami vairaki lietojuma
iestatijumi, kuri aprakstiti talak.

Tulkojamo failu
segmentacijas iestatijumi
tiek parnemti no saraksta
augsa esosas atminas.

Enabled: ja §i rltina ir atziméta, tulkoSanas atmina ir
ieslégta un programma to izmanto tulkoSanas procesa.

Enabled Lookup Penalty Concordance  Update
U4

1] W v

Lookup: ja ST rdtina ir atziméta, programma izmanto $o

segmentus.

e e . X L Attéls
atminu, lai automatiski piedavatu identiskus vai lidzigus iestatijumi.

37: tulkosanas atminu lietojuma

Penalty: soda procenti. Saja lauka noraditais procentu skaits tiek atnemts no atmina atrastajiem
tulkojumiem automatiski pieskirtas procentualas sakritibas. Pieméram, Seit ierakstot skaitli 5, visas
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Saja atmina atrastas identiskas atbilsmes netiks paraditas ka 100 % vai CM atbilsmes, bet gan ka 95 %

atbilsmes.

Concordance: ja St ritina ir atziméta, atmina tiks izmantota, lai piedavatu rezultatus Concordance jeb
manualiem atbilstibu meklésanas vaicajumiem.

Update: ja Si rltina ir atziméta, Saja atmina tiek saglabati jaunie iztulkotie un apstiprinatie segmenti.
Ja ratina nav atziméta, tulkojums netiek saglabats atmina.

Tranzlation Memory and Automated Translation
Select tranzlation memories and automated tranzlation servers for the language pairs zelected in the project. -

[

=% Al Language Pairs

4 |§ Tranzlation kemaory and Auto

Search
Penalties
Filters
|Jpdate
Language Rezources
4 =¥ | atvian [Latvial-»German [Germa
# B Translation Memony and Suto
ﬁ AutoSuggest Dictionanes

-

=% Latwvian [Latvial->Fuzsian [Ruzsia
b =» Latvian [Latvial->Englizsh [United

i Tranzlation Memory and Automated Tranzlation

Select tranzlation memory and autormated tranzlation servers to apply to
Al Language Pairs and specify whether to include them in lookup,
concardance zearch and whether to update them.

o= add = <f= Create - | [E% settings... | J | Remove v
M arme Enabled Lookup Penalty Concordance Update
By TM_TaA Sample LY. | v v 0 v v
By THM_esample_LV-E.. J o 5 o

25 TMS_Kriminallku.. v v/ |0 v

Attéls Nr. 38: jauna projekta izveides vedna 5. solis.

Saja soli projektam var pievienot ari AutoSuggest vardnicu, atverot vajadzigas valodu kombinacijas sadalu
(piem., Latvian (Latvia)-> Russian (Russia)) un péc tam sadalu AutoSuggest Dictionaries. Sis resurss ir
pieejams tikai atseviskiem valodu pariem, tadél nav atrodams sadala All Language Pairs.

Sestaja soli (Termbases) ir iespéjams projektam pievienot lokalas un servera terminologijas datu
bazes, izmantojot funkcijas Add > File-based Translation Memory un Add > Server-based Translation

Memory.

Tulko$anas laika
pievienojot jaunus terminus, tie
tiks pievienoti tikai

nokluséjuma datu bazei. To var
atpazit péc varda (default)
blakus datu bazes
nosaukumam, un ta vienmeér
atrodas saraksta augsa.

Lauka Languages, kas
atrodas zem datu bazu
saraksta, var parbaudit, vai
programma ir pareizi atpazinusi
terminologijas datu  bazes

valodas. Vajadzibas gadijuma
Saja lauka wvar arm noradit

ew Project

Termbases
Add termbazes to the project and order them. Set a default termbase and check the language mapping.

I ] E3

o= Add - o= Create - | Settings... | | Remave | Siet Defaulk

Enabled Termbaze Filter

2 ) tb_example [defauk] 6 [Mat zpecified)

Languages:

Froject Language Tembaze Language

nglizh [United Kingdaom) English
German [Germany] [Mat specified)
B Latvian [Latvia) Latvian
E Russian [Ruszia) | [Mot specified) -

Attéls Nr. 39: jauna projekta izveides vedna 6. solis.

projekta noraditajam valodam (Project Language) atbilstosas terminologijas datu bazes valodas (Termbase

Language).
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Septitais solis (SDL
PerfectMatch) nav obligats.

Tas piedava iespéju parnemt

jaunaja  faila  identiskas
tulkojuma dalas no ieprieks
tulkota divvalodu .sdIxliff

faila, ja abu failu struktdra
un saturs ir Joti dzigi. Lai to

izdaritu, katram projekta
failam  (Project File) ar
funkciju Add ir janorada

attiecigais ieprieks tulkotais
divvalodu  .sdixliff fails
(Previous Document).

Nakamajos divos
solos (Project Preparation
un Batch Processing
Settings) vajadzibas
gadijuma var izvéléties un
pielagot veicamos
automatiskos failu
apstrades uzdevumus.

Project Preparation
solt var izvéléties kadu no
nokluséjuma failu apstrades
uzdevumu virkném (Task
Sequence), konfigurét tas
vai izveidot jaunu virkni no
atseviskiem uzdevumiem
(Batch Tasks), noklikskinot
uz pogas Task Sequences.

Atsevisku  izvéléto
uzdevumu iestatijumus var
pielagot nakamaja soli —
Batch Processing Settings.
Seit atrodami iestatijumi,
kas attiecas, pieméram, uz
failu analizi, priekStulkosanu
un  atbilsmju  procentu
likmju diapazoniem (Fuzzy
Bands).

Kad ir veikti
vajadzigie iestatijumi,
noklikskinot uz Finish, var
palaist  tulkojamo  failu
sagatavoSanas procesus.
Kad visi automatiskie
procesi ir pabeigti, projektu
vedni var aizvért ar pogu
Close.

New Project M= B
SDL PerfectMatch
Add a previously translated bilingual document for each translatable file in the project, and then chooze what -
tranzlation ongin and status to uze for the transferred tranzlations.
J Project File Previouz Document
M Gemnan [Gemany] [04)
e Fussian (Russial o) 1] sample doc.doc
| | &
r— Tranzlation transfer options:
& Apply Perfectiatch and lock
" Use the original translation orgin and status
Attéls Nr. 40: jauna projekta izveides vedna 7. solis.
New Project 1 =]
Project Preparation
Select a predefined task sequence to run as part of project creation, or create a custom task sequence. -
Task Sequence; | Prepare without project Th j Task Sequences. . I
— Details
Description:
Convert, analyze and pre-translate files without creating project translation memornies.
Batch Tasks:
Carveart to Translatable Format
Copy to Target Languages
Apply Perfecthd atch
Pre-translate Files
Analyze Filez

Attéls Nr. 41: projekta vedna solis Project Preparation.

Mew Project

Batch Processing Settings
Review the project settings for the sele

cted tasks.

= B3

4 =¥ Al Language Pairs
4 L% Batch Processing
Ainalyze Files

— Pre-translate Settings

Miriimum match value: fioo -

Pre-translate Files

Fuzzp Bands
b =% Latvian [Latvial->Geman [Germ
b =% Latvian [Latvial-> Russian [Russi
p =% Latvian [Latvia)->Englizh [United

r— Translation ovensrite mode

" Keep existing translation
& Ovenwiite existing tranglation if better match found
 Always ovenwrite existing translation

™| Ouwerwite Perfesttatch translations

—after appluing tranzlations
¥ Confirm 100% matches

™ Lock 100% matches
[V Corfirm contest matches

™ Lock context matches

—*hen no match found
¥ Leave target segment emply
(o Copy source bo target
 Apply automated translstion

Attéls Nr. 42: projekta vedna solis Batch Processing Settings.
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PROJEKTA IESTATIJUMI UN PROJEKTU IESTATIJUMU SABLONI

Izveidotajiem projektiem joprojam ir iespéjams maintt un pielagot lielu daju no projekta
izveides laika noraditajiem iestatijumiem un resursiem. Projekta iestatijumiem var pieklGt
sadalas Editor, Files vai Projects cilné Home noklikskinot uz Project Settings kas atrodas | W&

rikjoslas kreisaja mala » | Project
Settings

Projekta iestatijumu loga ir pieejami gandriz visi = =
projektu izveides vedni konfigurétie iestatijumi un resursi,
iznemot projekta failus un failu apstrades uzdevumu
iestatijumus. Projekta iestatijumos var parvaldit talak E} File Types

4

- . - b [EJ Embedded Content Processors
minetos resursus un iestatijumus: e
B Werification
4
4

e tulkosanas atminas’ % Translation Quality Aesessment

e terminologijas datu bazes, _

A srdni 4 =% Al Language Pairs
¢ utoSuggest \fal‘ nicas, _ b B Translation Memaory and Automated Tran
e tulkojuma parbaudes, failu formatu un citus b Gl Tembases

iestatijumus. b L% Batch Processing
4 =% |atvian [Latvial->German [Germarny)

E Language Pairs

I.DrOJekta iestatijumu logs ir |dent|sks_pro‘Jek_ta fablonu b T T o s ey et T
(Project Template) logam, kuru var atvért izvélné File > b [ AutoSuggest Dictionaries
Setup > Project Templates. ¥ 4% Batch Processing

Projekta iestatijumu Zablonu noklus&juma mape ir: Attéls Nr. 43: projekta iestatijumu sadalu saraksts.

%userprofile%\Documents\Studio 2015\Project Templates

Ja tulkotajs darbosies tikai ar vienu valodas virzienu (piem. tulkos tikai LV-RU kombinacija), ir
ieteicams pielagot iestatljlumus nokluséjuma Sablona Default.sdltpl, lai Sis bltu vienigais pieejamais
Sablons projekta izveides pirmaja soli, tadéjadi novérsot iespéju tulkiem izvéléties nepareizu Sablonu.

TULKOJUMA PARBAUDES IESTATIJUMI

Tulkojuma kvalitates parbaudes iestatijumus var konfigurét projekta iestatijumos vai Sablona, kur tie
ir pieejami sadala Verification > QA Checker 3.0. Papildus nokluséjuma iestatijumiem ir ieteicams ieslégt
parbaudes funkcijas sadalas Punctuation (punktuacija) un Inconsistencies (nekonsekvences), ka paradits
attélos zemak.

Punctuation Inconsistencies

End punctuation Check for incongistent translations

Check that source and target end with the same punctuation | Waming

I

[ Ignore tags

[ Check for Spanish punctuation {j.;.! and 7) Waming [ lgnore case

Check for unintentional spaces befare: Waming Check for repeated words in target
RS lgnore numbers
lgnore case

Check for unedited fuzzy matches

@ Corfimed segmerts only

French compliant check (spaces are intentional)
Exira dots and spaces
Check for multiple spaces

Check for multiple dots

. Al rit
lgnore ellipsis dots (...) - SEqmerts
Only check if match scores below: |38
Check for extra space at the end of target segment Waming [ orly
Capitalization check ~ . B . B .
Check capitalization of inital letters Waming Attéls Nr. 45: nekonsekvencu parbaudes iestatijumi.
[ Check consistency of global capitalization Waming
Check for brackets

Attéls Nr. 44: punktuacijas parbaudes iestatijumi.
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2. SDL GROUPSHARE SERVERA PARVALDIBA

SDL GroupShare 2015 servera resursu un piekluves llmenu parvaldibai tiek izmantoti divi riki. Ar SDL
GroupShare timekla interfeisu ir iespéjams veidot un modificét tulkoSanas atminas, ka ari veidot lietotaju
kontus un parvaldit So kontu piek|uves tiesibas tulkoSanas atminam. Servera terminologijas datu bazu un to
piekluves tiesibu parvaldibai tiek izmantots SDL MultiTerm Administrator riks.

2.1. SDL GROUPSHARE TIMEKLA INTERFEISS

PIEKLUVE TIMEKLA INTERFEISAM - .
- z Jaunakas Chrome un Firefox

Servera timek|a interfeisam var piek|at ar timekla parlaku, versijas neatbalsta Microsoft
i tojot servera IP adresi vai doména nosaukumu, ja tads ir Silverlight. SDL Groupshare
lzmantojC A - N ') parvaldibai ieteicams lietot
konfiguréts. Péc nokluséjuma tam tiek izmantots ports 80. SDL Microsoft Internet Explorer.
GroupShare 2015 timekla interfeiss ir balstits uz Microsoft Silverlight
spraudna, kuru vairs neatbalsta jaunakas Google Chrome un Mozilla
FireFox versijas. Tadé| piekluvei timekla interfeisam ir ieteicams izmantot @ SDL Authentication Windows

Internet Explorer.

Username

Pieteikties interfeisa var, izmantojot SDL Authentication (SDL | | |
autentifikaciju). Piekluvei var izmantot ari Windows autentifikaciju Password
(standarta gadijumos ta ir atslégta), lai parnemtu lietotaju kontus no | |
Microsoft Windows Active Directory doména. L] Remember me

SAKUMA SKATA CILNE, PIEEJAMIE PARVALDIBAS RIKI . =egm

o ﬁnjf:k!a interfeisa sakuma sadala Home resursu parvaldibai ir Attéls  Nr. 46:  GroupShare

pieejamas $adas sadalas: pieteikianas logs.

o~ User Management (Lietotaju parvaldiba): sadala lietotaju, lietotaju

e a» User Management . - — X .- - . . —. - - . v

\§/  Manage users, user groups, sndorganizations | tiestbu parvaldibai. Saja sadala ir iespéjams ari parvietot tulkoSanas
atminas no vienas mapes uz citu.

Translation Memories Translation Memories (TulkoSanas atminas): modulis GroupShare
ﬂ b L L servera tulko3anas atminu izveidei un parvaldibai. Parvietot tulko3anas

atminas var sadala User Management.

Fields (Papildu informacijas lauki) un Language Resources

Fields
EE AR (Segmentacijas iestatijumi): sadalas tulko3anas atminas iestatijumu
Sabloniem. Seit ir iespéjams pielagot Sablonus, kurus péc tam var
Language Resources H . . . .
e s izmantot atminu izveidei.

Background Tasks (Fona procesi): sadala, kura var aplikot datu

] Background Tasks

B ===t e apstrades procesu rezultatus.
| stucture Infrastructure (Infrastruktra): sadala datu bazu un SQL datu bazu
=[] Menaoesenersand serveru parvaldibai.

&) Licensing Licensing (Licencésana): Saja sadala ir redzams servera maksimalais un
‘I.'. REOS0CiEeang paslaik izmantotais lietotaju licencu skaits.

Projects (Projekti): modulis GroupShare servera projektu parvaldibai.
View senver projects St funkcija nav pieejama Tiesu Administracijas serverim.
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2.2. LIETOTAJU PARVALDIBA

Sadala User Management ir pieejamas tris
cilnes — Users, Roles un Content. Sis cilnes un tajas
atrodamas funkcijas ir aprakstitas talakajas sadalas.

SDL GROUPSHARE 2015 PIEKLUVES TIESIBU
PAMATPRINCIPI

Fl

Piekluve. SDL GroupShare serveri piekluve tiek
pieskirta nevis failu lment (t.i. resursu jeb tulkosanas
atminu limen1), bet mapju (Organization) liment.

(% Add Organization

% Tiesu

4 (% Likumi
£% Darba atminas
(% Lietotaji

User Management *

(% Edit Organization D

Il
g

Users | Roles | Content

® Darba atminas

User Name

Pieskirta piekluve attiecas uz mapes saturu, tai skaita
art uz citam zemaka limena mapém.

Labaja pusé redzamaja ilustrativaja pieméra lietotajs, kuram ir piekluve otra
[fmena mapei “Likumi”, piekldst arT zemaku limenu mapém “Darba atminas”,

“Lietotaji” un to saturam.

Piekluves limenu parvaldiba. Piek|uvi resursiem var ierobezot ar piek|uves
[fmeniem. SDL GroupShare var brivi veidot jaunas lomas, bet ir pieejamas ari

daZas standarta lomas ar Sadiem piek]uves limeniem:

e Administrator (Administrators): Sai lomai nav ierobezZojumu.

e Translator (Tulkotajs): ir piekluve tulkoSanas atminam lasiSanas un rakstiSanas rezZima, bet nevar
tajas veikt masveida izmainas vai eksportét to saturu.

e External Translator (Ar3tata tulkotajs): ir piekluve atminam tikai lasisanas reZzima.

e Guest (Viesis): ir piekJuve atminam tikai lasiSanas reZima. External Translator lomas dublikats.

e Project Manager (Projektu vaditajs): ir piekluve atminam lasiSanas un rakstiSanas rezima, var redigét
tulkoSanas iestatijumus, importét un eksportét datus un veikt masveida izmainas.

e Power User (Prasmigs lietotajs): papildus Project Manager tiesibam 31 loma var veidot mapes

(Organizations) SDL GroupShare serverd.

Attéls Nr. 47: sadala User Management

4 (% Tiesu
4 8 Likumi
£% Darba atminas

£% Lietotaji

e MultiTerm Guest (MultiTerm viesis): $Tloma vairs netiek izmantota GroupShare versija 2015.

Power User, Project Manager, Translator, External Translator un Guest lomu piek|uves tiesibas var pielagot.

LIETOTAJU UN PIEKLUVES TIESIBU PARVALDIBA

Sadala User Management ir pieejamas tris cilnes: Users — cilne lietotaju profilu parvaldibai; Roles —
cilne piekjuves parvaldibai; Content — cilne tulko$anas atminu resursu parvietosanai.

Cilnes Users galvena funkcija ir lietotaju profilu izveide. Lai izveidotu jaunu lietotaju, noklikSkiniet uz

pogas Add User $is cilnes rikjosla. o
& Lietotaji : Add User

Pirmaja__soli (Details) noradiet O Detas
vajadzigo informaciju. Obligatie lauki ir:
O Roles

e User Name: lietotajvards. Lietotajs
to izmantos, lai pieslégtos sistémai.

e Display Name: paradamais vards.
Seit var izmantot lietotaja pilnu
vardu.

e Password & Confirm Password:
parole un paroles apstiprinasana.
Parolei jasatur vismaz vienu ciparu,
vienu mazo un vienu lielo burtu.

Lauki, kuri nav jaaizpilda obligati:

e Description: apraksts.

User Account Details

User Type: [E:N

User Name |

X

Display Name |

Description

Password |

Confirm Password |

Email Address |

Phone Number |

Cancel

Attéls Nr. 48: jauna lietotaja izveide: lietotaja informacija.
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e Email Address: lietotaja e-pasta adrese. E-pasta lauks tiek izmantots, ja SDL GroupShare serverim ir
pieejams Projects modulis, lai informétu lietotaju par projektu pieejamibu.
e Phone number: telefona numurs.

& Likumi : Add User X
Otraja __soli  (Roles) pieskiriet
lietotdjam nepieciedamas lomas. Loga ~ ©Peaie User Roles
augséja dala (1) tiek paraditas = o Roes
pieskirtas tiesibas, bet pieskirt tiesibas

V== - . .- O ization / Lib ~ Role
var loga apak$éja dala (2) — kreisaja B °
- . -1 . . .- Darba atminas Translator
kolonna izvélieties mapi un labaja
- — - . . v Likumi External Translator
kolonna atziméjiet nepiecieSamo lomu,
kura noteiks piekluves limeni 3ai
mapei. Augstaka limena mapju tiesibas 4 T ] pemiistrtor
. - =1 - . 4 Likumi Power User
attiecas arm uz zemakiem limeniem. K _ -
4 . Darba atminas [] Translater
Jaunu profilu vai izmainas lietotaja Lietotas [ External Translator
profila nevar saglabat, ja lietotajam L suest
o vy . . |_| Project Manager
nav pieskirta vismaz viena loma.
“ Cancel

Attéls Nr. 49: jauna lietotaja izveide: lomu pieskirSana.

Jaunais lietotaja profils tiek izveidots paslaik atlasitaja map€, bet lietotaja profila atrasanas vieta
neietekmés lietotaja piekluves tiesibas.

Citas $aja cilné pieejamas funkcijas ir:

o Edit User: redigét lietotaju. Sis funkcijas vednis ir identisks Add User funkcijas vednim.

e Move User: parvietot lietotaju uz citu mapi. St funkcija neietekmé lietotaja piekluves tiesibas, bet tikai
lietotaja profila atrasanas vietu.

e Delete User: nodzést lietotaju.

Cilné Roles var érti veikt masveida piek]uves tiesibu izmainas. Cilnes galvenaja skata redzami lietotaju
piekluves lTmeni atlasitajai mapei, kas ir kategorizéti péc lomam. Blakus katrai lomai ir pogas Add un
Remove, kuras palidzés veikt masveida izmainas.

Turklat $aja cilné ir iespéjams konfigurét jaunas vai pielagot nokluséjuma lomu piek|uves tiesibas, izmantojot
rikjosla atrodamo pogu Roles.

Tresa cilne — Content, ir paredzéta tulko3anas atminu parvaldibai. Saja cilné pieejamas $adas funkcijas:

e Move Resource: parvietot resursu (t.i. tulkoSanas atminu vai datu bazi) uz citu mapi (Organization).

e Link Resource: izveidot saiti resursam. Ar So funkciju var izveidot tulkoSanas atminai simbolisku saiti cita
mapé, nemainot tas faktisko atrasanas vietu. Lietotaji, kuriem ir piekluve mapei, kura atrodas $ada
simboliska saite, var piek|Qt attiecigajai tulkoSanas atminai.

e Unlink Resource: nonemt resursa saiti.

Neatkarigi no atlasitas cilnes ir pieejamas $adas funkcijas:

e Add, Edit, Delete Organization: attiecigi pievienot, mainit vai dzést mapi. Mape tiek veidota izvélétaja
[TmenT, un péc mapes izveides to nevar parvietot. Mapi nevar dzést, ja taja ir tulkoSanas atminas, datu
bazes vai lietotaju profili.

e Add Library: pievienot Library mapi. Library mapes atskiriba no Organization mapém atskiras ar to, ka
tajas nevar glabat lietotaju profilus. Noklikskinot uz Library mapes, rikjosla klUst pieejamas Edit un
Delete Library funkcijas.

e Refresh: atsvaidzinat skatu.
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2.3. TULKOSANAS ATMINAS

Sadala Translation Memories ir pieejamas funkcijas tulkoSanas atminu izveidei un parvaldibai, ka ari
datu importésanai un eksportésanai. Galvena atskiriba starp lokalam un servera atminam ir ta, ka servera
atminai var pievienot vairakus valodu parus un to vienlaikus var lietot vairaki lietotaji.

TULKOSANAS ATMINU PARVALDIBA

Pirma no sadala Translation Memories atrodamajam rikjoslas funkcijam ir tulkoSanas atminas
izveides funkcija Create, ar kuru var atvért tulkoSanas atminas izveides vedni.

Servera tulkoSanas atminu vednim ir pieejamas tadas pasas funkcijas un opcijas ka lokalu tulkosanas
atminu vednim (skat. sadalu , TulkoSanas atminas izveides vednis” 9. lpp.) ar daziem iznémumiem, kas
aplakoti talak.

Pirmaja _ soli(Select  Location) | Select Location
izvéIné Location jéatlasa mape, kura Under organization, select a resource group to determine the access rights for the translation
glabasies tulkosanas atmina. Atminas memory. Under Container, select the container that holds the translation memory.
atrasanas vieta ietekmés lietotaju
piekluves tiesibas Sai tulkoSanas atminai.
Izvélné Container janorada SQL datu |Container |Tiesu_Container -
baze, kura glabasies atmina. Viena datu
bazé var glabat vairakas atminas. Papildu Attéls Nr. 50: serverbazétas tulkoganas atminas izveides 1. solis.
SQL datu bazes var izveidot sadala
Infrastructure. Ja tas netiks veidotas, tad atminas var art turpmak glabat datu bazé Tiesu_Container.

Location lDarba atminas A

Otraja soli (General Properties) noradiet atminas nosaukumu lauka Name. Seit var aizpildit ari divus
neobligatus informacijas laukus: Description un Copyright, ka arT nomainitt funkciju Recognize (netulkojamu
elementu atpazisana) un Count as one if words (vardu skaita aprékins) iestatijumus (skat. sadalu Fields and
Settings — informdcijas lauki un atminas iestatijumi 10. lpp.)

Tresaja soli (Language Pairs), janorada atminai vismaz viena valodu kombinacija. Atskiriba no lokalam
atminam, viena servera atmina var bit vairakas valodu kombinacijas.

Nakamajos solos (Fields un Language Resources), pielagojiet informacijas laukus, abreviatiru
atpaziSanas un segmentacijas iestatijumus (skat. sadalas Fields and Settings — informdcijas lauki un atminas
iestatijumi un Language Resources — abreviatiru atpazisanas un teikumu segmentdcijas iestatijumi 10. lpp.).

Pédéja soli (Summary), vélreiz tiek apkopota informacija par veidojamo tulkoSanas atminu.
Noklikskiniet uz Finish, lai pabeigtu atminas izveidi.

Citas Saja sadala pieejamas funkcijas:

e Edit: redigét tulkoSanas atminas iestatijumus.
e Delete: dzést tulkosanas atminu.

e Copy: kopét tulkoSanas atminas iestatijumus un izmantot tos jaunas tulkoSanas atminas izveidei. Tiek
atverts vednis, kura var pielagot nokopétos iestatijumus. Atminas saturs netiek kopéts.

e Import, Export: importét un eksportét tulkoSanas atminu saturu (skat. sadalu Importésana,

eksportésana, datu apmainas formati 13.lpp.) Atskiriba no lokalam tulkosanas atminam papildus
janorada art apstradajamais valodu paris. Eksportétie faili ir pieejami sadala Background Tasks.
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e Tune: optimizét tulko$anas atminu. ST funkcija atvérs izvélni, kurd var palaist Re-compute Fuzzy Index
Statistics (tulkoSanas atminas dal€ju sakritibu statistikas optimizaciju) vai Re-index Translation Memory
(pilnu tulkoSanas atminas parindeksésanu). Ja ir nepiecieSams veikt tulkoSanas atminas optimizaciju, uz
to Saja sadala norada statuss Re-compute recommended. Atminai nepiecieSams veikt pilnigu
parindeksésanu, ja atminas Language Resources iestatijumos vai netulkojamo elementu atpazisanas
iestatljumos (Edit -> General Properties -> Recognize vai Count as one if words) tiek veiktas izmainas.

e Export Fields, Export Language Resources: eksportét papildu informacijas lauku vai segmentacijas
iestatljumus Sablonos, lai izmantotu tos citu atminu izveidé.

e Refresh: atsvaidzinat skatu.

SADALAS FIELDS, LANGUAGE RESOURCES

SDL GroupShare sadalas Fields un Language Resources ir iespéjams konfigurét jaunus un pielagot
esosus iestatijumu Sablonus, lai izmantotu tos tulkoSanas atminu izveides vedni. (skat. sadalas Fields and
Settings — informacijas lauki un atminas iestatijumi un Language Resources — abreviatiru atpazisanas un
teikumu segmentdcijas iestatijumi 10. lpp.)

SADALA BACKGROUND TASKS

Sadala Background Tasks var aplikot sistémas atskaites par tadiem fona procesiem ka tulkoSanas
atminu statistikas atjaunos$anu, tulko$anas atminu parindeksé$anu, datu importé$anu un eksportésanu. Saja
sadala var lejupieladét no tulkosanas atminas eksportétus segmentus.

SADALA INFTRASTRUCTURE

Sadala Infrastructure ir pieejamas divas cilnes:
e Servers (SQL serveris): Saja cilné var parvaldit SDL GroupShare pieslégtus SQL serverus, bet izmainas
Saja cilné parasti tiek veiktas tikai instalacijas laika. Papildu izmainas $aja cilné nav vajadzigas.

e Containers (konteineri jeb SQL datu bazes): cilne SQL datu bazu parvaldibai. Ja datu organizacijas
noltkos bls nepiecieSams izveidot atsevisku datu bazi, tad to var izdarit $aja cilné. Paslaik Tiesu
administracijas resursi glabajas SQL datu bazé “Tiesu_Container”.

Ipasa piezime par MultiTerm terminologijas datu bazém — at3kirtba no tulko3anas atminam, katra
terminologijas datu baze tiek veidota ka atseviska SQL datu baze.

SADALA LICENSING

Sadala Licensing var aplikot informaciju par SDL GroupShare licences ierobezojumiem. Seit bis redzams
maksimalais un paslaik serverim pieslégto lietotaju skaits, ka ari maksimalais un izmantotais tulkoSanas
atminas segmentu (Translation Units — TU) skaits.
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2.4. SERVERA TERMINOLOGIJAS DATU BAZU PARVALDIBA

SDL GroupShare 2015 versija MultiTerm terminologijas datu bazu izveidei un parvaldibai nepiecieSams
izmantot atsevisku programmu — SDL MultiTerm Administrator. Starp SDL GroupShare un MultiTerm
serveriem tiek sinhronizéts lietotaju saraksts, bet piekluves tiesibas terminologijas datu bazém japieskir
programma MultiTerm Administrator. Turklat Saja programma nevar piekl|it terminologijas datu bazes
saturam ierakstu imenr.

TERMINOLOGIJAS DATU BAZES IZVEIDES VEDNIS

MultiTerm Admininistrator jaunas terminologijas datu bazes izveides
vednis ir identisks programmas MultiTerm Desktop vednim (skat. sadalu
Terminologijas datu bazes izveides vednis 15.1pp.) Servera terminologijas P  Fikers
datubazes datu parvaldiba (importésana, eksportésana) arl sakrit ar 5 Layouts
attiecigajam darbitbam programma Multiterm (skat. sadalu Terminologijas | Input Models
datu bazes satura importésana un eksportéSana 17.lpp.) Lai programma » -'_? Export Defiritions
MultiTerm Administrator atlasttajai datu bazei palaistu importésanas un i & Import Definitions
eksportésanas funkcijas, atveriet sadalu Public Objects > Import Definitions & B Roles
vai Export Definitions sadalas (skat. attélu pa labi). A€ Users

= @ TBS_Likums
= &, Public Objects

Attéls Nr. 51: sadalu struktira
programma MultiTerm

Parasti jaunai terminologijas datu bazei sakotngji var pieklut un to . - .. .

“« ”

parvaldit tikai nokluséjuma lietotaji “sa”, “super” un lietotajs, kurs

datu bazi izveidoja. Citi lietotaji ar administratora tiesibam nevar Jba_ur]ém 'Ecla(rmir]glogija§ i?fu
iek|Gt 3ai terminologijas datubazei. azem sakotneji var piekjut
piex &l tikai lietotajs, kurs to
izveidoja un nokluséjuma
lietotaji sa un super.

TERMINOLOGIJAS DATU BAZU PIEKLUVES PARVALDIBA

Atskiriba no tulkosanas atminam, terminologijas datu bazes
netiek glabatas mapés jeb organizacijas. Lietotajiem japieskir
piekluvi katrai terminologijas datu bazei atseviski.

Add Users x|

Lai lietotajam pieskirtu kadu piek|uves limeni, vins vispirms prer—
japievieno terminologijas datu bazei, attiecigaja datu bazé ar labo test_lranz
peles taustinu noklikskinot uz sadalas Users un péc tam uz Add
Users. Tiks atvérts Add Users dialoglodzins ar lietotaju sarakstu, kas
tiek parnemts no SDL GroupShare servera. Atlasiet vajadzigos
lietotajus un, izmantojot pogu Add, pievienojiet terminologijas datu
bazei.

Add Cancel | Hep |

Péc tam sadala Users atrodiet vajadzigo lietotaju, ar labo peles
pogu noklikskiniet uz ta un izvélné klikgkiniet uz Edit. Tiks paradits Attéls Nr.52:lietotaju pievienosanas logs.

dialoglodzins ar divam kolonnam: Edit Role Membership [x]
e Roles in termbase: terminologijas datu baze U= et s
pieejamas lomas, kuras var pieskirt I A WMearmber of
lietotajam, Expert User T ranzlator

e Member of: lietotajam pieskirtas lomas. Fuble
Parvietojiet vajadzigo lomu no lauka Roles in
termbase uz lauku Member of , izmantojot pogu
>>. Sada veida var veikt atsevisku lietotdju lomu
izmainas. Metode, ar kuru var veikt masveida
piekluves limenu izmainas, ir aprakstita zemak.

(0] Cancel Help

Attéls Nr. 53: lomu pieskirsanas lodzins.



Nokluséjuma lomas ir:

e Public: lietotajs var lasit atminas saturu, bet vinam nav redigésanas tiesibu.
e Expert User: lietotajam ir pilnas lasiSanas, redigésanas un dzeésanas tiesibas. Lietotajs var importét un
eksportét terminologijas datu bazes saturu.

Terminologijas datu bazém ,TBS_Spriedumi” un ,TBS_Likums” tika pievienota viena pielagota loma:
Translator.

e TBS_ Likums”: lomai Translator ir tikai lasiSanas tiesibas.
e ,TBS Spriedumi”: lomai Translator ir gan lasiSanas, gan redigésanas tiesibas, bet nav importésanas,
eksportésanas un dzésanas tiesibu.

Lai terminologijas datu bazei izveidotu jaunu lomu ar | 5. [§ TBS_Spriedumi
pielagotam tiesibam, noklikskiniet ar labo peles taustinu uz Roles - & Public Objects
un péc tam uz New Role péc ka tiks atvérts lomas izveides EQW
vednis. o
Lidziga veida var redigét esosas lomas: noklikskiniet ar labo peles . [~ & Public
taustinu uz attiecigas lomas un péc tam uz Edit Role. a W
Lomas iestatijumu pédéja cilné (Role Members), redigéjamai G- 82 Users Delete Role
lomai var pievienot lietotajus. Lietotaji Seit ir sagrupéti divas
kolonnas: Attéls Nr. 54: lomu izveides un pielagosanas
funkcijas.
e Termbase users (termbazei pievienotie lietotaji,
kuriem var p|e§k|rt So IOmU), General | Tembase Wide Access Rules | Entry Wide Access Rules  Role Members |
e Role members (lietotaji, kuriem ir pieskirta Si Teimbase users: Fiale members:
IO ma ) . ludrmila_za d aberzina -
marina_go agnese_bo
Izvélieties vienu vai vairakus lietotajus un ar pogu >> e
parnesiet tos no lauka Termbase users uz lauku Role » | 2232‘_‘35!‘3-"3”3-'3'
z
members. « | reen
zarmite_gr anita_ur
X= g= .= - . . e vlsv .= I t
Sada veida var érti veikt lomu pieskiranu masveida. per iy
avetlang iv apriedniece
aurpena
ausma_kl
dfagniia__sm
Sone =l
QK I Cancel | Help |

Attéls Nr. 55: lomas lietotaju parvaldibas sadala Role
Members.
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3. PROBLEMU NOVERSANA

Saja nodala ir aplikotas bieZi sastopamas problémas un to risindjumu metodes, ki ari risinajumu
metodologija citam problémam (datu atjaunos$ana, profilu atiestatiSsana). Sadalas nobeiguma ir noraditi
papildu informacijas avoti un tehniska atbalsta kontaktinformacija.

BIEZI SASTOPAMAS PROBLEMAS

Saja sadala aprakstitas biezi sastopamas problémas, to iemesli un darbibas to novérianai.

Probléma: neizdodas izveidot projektu.

lemesls: projektam pievienotais tulkojamais fails ir atverts cita programma.

Kltidas pazinojums: The file is open in another application.

Risinajums: aizveriet programmu, kura ir atvérts tulkojamais fails, piem. Microsoft Word, un turpiniet
projekta sagatavoSanas procesu. Nav nepiecieSams aizvért projekta izveides vedni. Faila sagatavosanas
procesus vedna pédgéja soll var atkartoti palaist ar pogu Restart. Ja citas failu izmantojosas programmas
aizvérsana nepalidz, tad piesakieties datora lietotaja profila no jauna vai parstartéjiet datoru, lai aizvértu
fona procesu, kura fails ir atveérts.

Probléma: nedarbojas tulko$anas atminas un terminologijas datu bazes.
lemesls: ja ir probléma ar servera resursiem, iespéjams, datoram ir pazudis interneta savienojums vai tika
ievaditi nepareizi piekluves dati. Ja ir probléma ar lokaliem resursiem, tad pastav iespé€ja, ka tie ir parvietoti
uz citu mapi.
KlGdu pazinojumi:

The translation provider ‘X’ could not be opened and has been disabled. ...

Could not connect to the ‘X’ termbase, so you cannot use it for term recognition.
Risinajums: Parbaudiet projekta iestatijumus (Project Settings). Visiem resursiem jabat ieslégtiem. Atslégtam
atminam, kuras nav iespéjams atkartoti pieslégt projektam, atziméjot rutinu Enabled, paradisies aprakstoss
kladas pazinojums.

b B Project Template i Translation Memory and Automated Translation

[EL File Types Select translation memory and automated translation servers to apply to All Language Pairs and
[EJ Embedded Content Pracessors B specify whether to include them in lookup. cancordance search and whether to update them.
=} Verification
E Tranzlation Quality Azsessment o Add - b Create -
B Language Fairs Mame Enabled Lookup Penalty Concordance Update
4 =% AllLanguage Pairs B TMS_Kriminallikums L4 ¥ |0 Ld
4 B Translation Memory and Automated Tran B THS_Spriedumi v v |B v v
Search
Penaltizs
Filters
Update
Language Resources
b @ Tembases
» 4% Batch Processing

[E% settings... | ' | Remove |ﬂ‘_1mport... B, Export...

[

E Project Template [~ Tembazes
E‘é File Types ﬁ Add termbases to the project and order them. Set a default termbase and check the language mapping.
[E] Embedded Content Processors

Werification
5 Tl @y At o= add ~ o Create ~ | Settings. .. | ¥ ‘ Remove | Set Default

v v v v v

4 [ Language Pairs Enabled Tembase Filter
4 =% Al Language Pairs F TBS5_S5priedumi [defauk] @ (Mot specified)

b B Tranelation Memory and Automated Tran - TES Likums @ (Mot specilied)

4 |1 Tembases

Search Settings
b 43 Batch Processing

Attéls Nr. 56: projekta tulkoSanas atminu un termbazu iestatijumi.

Servera resursiem:
e Parbaudiet pieejas datus File > Setup > Servers dialoglodzina (skat. Attéls Nr. 19), izmantojot funkciju
Check Server Availability. Ja piekluves dati ir pareizi, tad kolonna Status serverim bus noradits
statuss Available. Pretéja gadijuma izlabojiet lietotaja pieejas datus ar funkciju Edit.
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e Ja  probléema  joprojam

EL add. .. E.- Edit... E‘ Delete | E'; Check Server Availability | k! Clear Stored Credentials | E'E. Change Passward

pastav, parstartéjiet
programmu, nonemiet Status
.. ’ i@ hitp: /487 246,184,139/ Available,
resursus ar funkciju Remove & sl & tmas Balatle,
un pievienojiet tos
projektam no jauna.
Lokalajiem resursiem: Cose | Heb

e Nonemiet resursus ar
funkciju Remove un manuali
pievienojiet tos projektam no jauna. Ja probléma joprojam pastav, parstartéjiet programmu.

Attéls Nr. 57: serveru savienojumu parvaldibas logs.

Probléma: netulkojams fails; nevar atvért failu programma Trados Studio.

lemesls: bojats fails

Risinajums: NepiecieSams parbaudit, vai failu ir iespéjams atvért nokluséjuma programma, piem., vai .doc
failu var atvért Microsoft Word programma. Ja failu var atvért Microsoft Word, bet to neizdodas atveért
Trados Studio, ieteicams to saglabat .docx, nevis .doc formata, un pievienot projektam .docx failu.

Probléma: nevar saglabat iztulkoto dokumentu; nav iespéjams atvért saglabato failu.

lemesls: parasti — triukstosi tagi.

KlGdas pazinojums: —

Risinajums: Atveriet tulkojamo failu sadala Editor un cilné Review palaidiet funkciju Verify.
Apakscilné Messages paradisies pazinojumi par faila atrastam klGdam. Pazinojumus “Segment has

not been translated” var ignorét, bet Severity: Error ( E:9’) [Tmena pazinojumus ar atribdtu Origin:
Tag Verifier nepiecieSams izlabot (piem. “Tag X’ is missing”) pirms iztulkotd dokumenta
saglabasanas.

Werify

Meszages [12]
{3 12 Errors 0 YWarnings (D 0 Maokes D Shaw Messages For Ackive Dacument Only D Shaow Ignored Messages
Severity Meszage Origin Diocument -
<] Tag "<footnotereference style="Footnote Reference’ autonumber="2"/.. | Tag Verifier sample doc.doc. sdlxliff
a Tag "<footnotereference style="Footnote Reference autonumber="1"/.. | Tag Verifier sample doc.doc. sdlxliff
a Segment has not been banslated - "Sis i jauns e, " 04 Checker 3.0 sample doc.doc. sdl:lf
a Segment haz not been tanglated - "Sis it cita tei " 04 Checker 3.0 sample doc.doc. sdliff
a Segment has not been translated - "Lietot3j: var d.." 04 Checker 3.0 sample doc.doc. sdliff

Attéls Nr. 58: kladu zinojumi.

Probléma: izjaukts/neérts logu izkartojums.

lemesls: Programma ir iespéjams brivi pielagot sadala Editor pieejamos funkciju logus, kadé| ir iespéjams
nejausi aizvert vai paslépt dazus no tiem.

Kltdas pazinojumi: —

Risinajums: Atiestatit logu izkartojumu ir iesp&jams cilné View ar funkciju Reset Window Layout.

Probléma: Pazudis projekts.

lemesls: Projekts tika atfiltréts vai pilntba iznemts no projektu saraksta Projects (
Sada!é Projects. Filter Projects

Kladas pazinojums: — Status:

Risinajums: Atiestatiet projektu filtru sadala Projects uz Show All Projects. | Show all projects =l
Ja projektu joprojam nevar atrast, tas tika iznemts no saraksta. No saraksta Due date:

iznemtus projektus var pievienot atpakal, atverot attieciga projekta .sdlproj (EERENECERE 5
failu. Parbaudiet attieciga projekta mapi, kas parasti glabajas kopéja Trados |T5Php:u:v - ]

Studio projektu mapé:
%userprofile%\Documents\Studio 2015\Projects\

Attéls Nr. 59: projektu filtrs.
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Probléma: Object reference not set to an instance of an object
Kltidas pazinojums: Object reference not set to an instance of an object
Risinajums: aplukots nakamaja sadala — Kludu pazinojumi un izvérstais klidas pazinojuma skats.

KLUDU PAZINOJUMI UN IZVERSTAIS KLUDAS PAZINOJUMA SKATS

Liela dala klidu raksturo to pamata esoSo problému un norada uz tas iemeslu pasa kladas
pazinojuma. Ar $o informaciju dazreiz pietiek, lai atrisinatu problému. Pieméri:

piekluves dati.

|®| Authertication Failed. Please check that the uzemame and password entered are comect for this server.

= R

A

Attéls Nr. 60: kludas pazinojums nepareizu servera piekluves datu gadijuma.

Sabojats  .sdIxliff fails.

.
Atverot failu ar teksta

redaktoru, 2626. rinda I@' The tag' start tag on line 2626 position 882 does not match the end tag of 'tag-defs’. Line 3927, pozition 327157,
’ . | !

var atrast klGdainu XML

ierakstu. Sakuma tagam _

Y= e H ok,
nav pareiza atbilsto3a 4
beigu taga.

Attéls Nr. 61: pazinojums par problému divvalodu faila.

Viens no izngmumiem ir pazinojums “Object

refecence not set to an instance of an object”, kas ir
neaprakstits klidas pazinojums. Tas var noradit uz
dazadam problémam. Lai meklétu problémas iemeslu,

|'®'| Object reference not set to an instance of an object.
"\.____/"

tados gadijumos nepiecieSams atvért izvérstu kladas =R /
pazinojuma skatu ar pogu r Savukart ar disketes {\ttels Nr. 62: klidas pazinojums bez viennozimigi skaidra
iemesla.
pogu H var saglabat izvérstu kladas pazinojumu .xml faila. Izveérstais skats ir pieejams ne tikai
. ) o “Object refecence not set to an
Sis ir standarta kludas pazinojums .NET Framework instance of an object”
neaprakstitam problémam. pazinojumiem.
- Object reference not set ta an instance of an object.
..A |Obiect reference not set bo aninstance of an object. | -
Type Syatern MulR eferencel weeption, macorlib, Yersion=4 0.0.0, Culture=neutral, PublickeyT oken=h77a5ch6193408
HelpLink
Source SdlVerification. JAChecker
HResuk 2147467261

4 Stackirace
at SdlWerfication BAChecker Processors ProcessarRegE » CheckRegE #[HASegmentPair currentSegmentPair]
at Sdl.¥erification.JAChecker. Processors. ProcessorRegE « Process(|SettingsBundle settingsBundle, QASegmentPair current
at Sd¥Verfication Q4Checker. DACheckerProcessing YenfyBASeamentPair currentPair]
at SdlMerification. B4Checker. JACheckerM ain. ProcessParagraphUnit{IParagraph U nit paragraphUnit]
at Sdl.FileTypeSupport. Framework. Core Utilities. Bilingualspi. BilingualContentH andlerddapter. Proces:ParagraphU nit(| Paragr
at Sdl.FileTypeSuppart. Framewark. Integration.AbstiactBilingualProcessarContainer. ProcessParagraphUnit{| ParagraphUnit p
at Sdl.FileTypeSuppart. Framework Biingualdpi AbstractBilingualContentProcessor. ProcessParagraphUnit| Paragraphlnit pa

at SdlFileTypeSuppait. Framewark. Inteqration. L ocationtd arkerl acator. ProcessParagraphUnit(| P aragraphU nit paragraphUnit] |~
4 »

Izvérstaja skata ir
EH / iespéjams atrast dazZas
3

%

Attéls Nr. 63: klidas pazinojums izvérstaja skata. 35



norades uz problémas iemeslu lauka Source un sadalas Stacktrace sakuma. Saja gadijuma tas norada uz
nepiemeérotiem iestatijumiem QA Checker automatiskas parbaudes iestatijumos, kur ir klGdaini konfiguréts
RegEx (Regular Expression) filtrs. Péc filtra iestatijumu izlabosSanas Sis pazinojums pazdd.

Citos gadijumos $aja sadala var bit redzamas problémas ar Word FileType, kas noraditu uz
problémam ar faila sagatavo$anu vai citiem iemesliem. Labakais informacijas avots sadam problémam ir
programmas  izstradataja tehniska  atbalsta  klidas pazinojumu portals, SDL Gateway
(https://gateway.sdl.com/).

SDL TRADOS STUDIO BOJATU PROJEKTU DATU ATJAUNOSANA

Ja tulkojamaja faila péc sistémas vai programmas klidas ir pazudusi dala no tulkojuma vai SDL
Trados Studio projekta failu vairs nevar atvért, tad visus apstiprinatos segmentus ir iespéjams atglt no
tulkoSanas atminam. Ja tulkotaja datoram ir notikusi avarija un tas vairs nedarbojas, tad apstiprinatos
segmentus joprojam var atgit no servera tulkoSanas atminas.

Ja bojata projekta originals vairs nav pieejams, tad, veidojot jaunu projektu, no tulkosanas atminam
tiks automatiski parnemti ieprieks apstiprinatie segmentu tulkojumi. Jauna projekta izveides laika
automatiski tiek palaista funkcija Pre-translate files. Ja projekts jau ir
izveidots un ir pieejams identisks fails, kas nav tulkots vai ir daléji
iztulkots, tad sadalas Editor vai Files cilné Home palaidiet funkciju
Batch Task > Pre-translate files funkciju, lai priek3tulkotu $o failu. [ lenddinreemnismmts

" Keep existing translation

— Pre-tranzlate Settings
I Minirum match value: a5 I

Stradajot ar servera atminu , TMS_Spriedumi”, kurai ir piemérots 5
procentu sakritibas sods, funkcijas Pre-Translate iestatijumos ||« auays ovenite esisting translation
jasamazina Minimum match value lidz 95 procentiem. I e e

¢ Ovenwrite existing translation i better match found

— After applying translations
IV Canfirm 100% matches

Turklat ne vienmeér ir nepiecieSams izgat tulkojumu no atminas. Awals Nr. 64: funkcijas Pre-Translate
Vispirms ir vérts parbaudtt ari Sos avotus: iestatijumi.

e AutoSave mapi: suserprofile%\Documents\Studio 2015\AutoSave
Ar nokluséjuma iestatijumiem funkcija AutoSave saglaba atvéertu .sdIxliff failu reizi 10 minatés, un So
laiku var pielagot programmas iestatijumos izvélné File > Options.

e Projekta .sdIxliff tulkojuma failus, ja ir sabojats tikai .sdlproj iestatijumu fails.

Ja Sie avoti ir pieejami, tad labak parnemt tulkojumu no tiem, jo tajos bis atrodami ari neapstiprinatie
segmenti.

PROGRAMMAS PILNIGA ATIESTATISANA

Gadijumos, kad ir radusas problémas ar instalaciju vai lietotaja konfiguracijas profilu, programmu ir
iespéjams atiestatit, pilntlba dzéSot daZus konfiguracijas failus.
Palaizot programmu no jauna, ta automatiski izveidos jaunus
iestatljuma failus ar standarta parametriem.

Pirms iestatijumu
atiestatiSanas ir ieteicams
veciem iestatijumiem

Lietotaja profila atiestatiSanai pietiek ar Sis mapes satura dzésanu: izveidot rezerves kopiju.

suserprofile%\AppData\Roaming\SDL
Piln1gai atiestatiSanai ir garaks dzéSamo konfiguracijas failu un mapju saraksts:

suserprofile%\Documents\Studio 2015\Projects\projects.xml — projektu saraksta
indekss, no kura programma tiek veidots saraksts sadala Projects.

suserprofile%\AppData\Roaming\SDL — lietotaja profila iestatijumi, spraudni.
%userprofile%\AppData\Local\SDL — programmas zurnalfaili, spraudni.
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%userprofile%\Documents\Studio 2015\Project Templates — projekta Sablonu
iestatijumu mape.

Programmas parinstalésana nepalidzés atiestatit lietotaja profilu, jo tas laika $is mapes netiek dzéstas/tiritas.

FAILU ASOCIACIJAS, PROBLEMAS PEC VECAS VERSIJAS ATINSTALACIJAS

Ja péc jaunas versijas instalacijas atinstalésiet vecaku programmas versiju, tad arf jaunajai versijai tiks
nonemtas SDL failu asociacijas. Sos iestatijumus var viegli izlabot ar atru parinstalaciju. Datora vadibas panelt
(Control Panel) palaidiet funkciju Uninstall or change a program, atrodiet saraksta SDL Trados Studio 2015
SR3 un palaidiet funkciju Repair. ST parinstalacija neietekmés programmas iestatijumus vai lietotaja profilu.

Sadu parinstalaciju ir ieteicams palaist ari programmai MultiTerm.

Manuali piesaistit failu asociacijas neizdosies.

PAPILDU INFORMACIJAS AVOTI UN TEHNISKA ATBALSTA KONTAKTI

Papildu informacijas avotus par Saja rokasgramata nepieminétiem iestatijumiem vai neaprakstitam
problémam varat atrast $ajas vietnés:

e SDL Gateway (https://gateway.sdl.com/) — programmas izstradataja aktualas tehniskas informacijas
un klGdas pazinojumu datubaze.

e SDL dokumentacijas centrs (http://docs.sdl.com/) — programmas izstradataja dokumentacijas
centrs, kur var iegit visu versiju SDL Trados Studio un SDL GroupShare rokasgramatas angju valoda.

e SDL Community forums (https://community.sdl.com/) — programmas izstradataja veidotais forums,
kur ir pieejama tehniska atbalsta sadala.

e ProZ forums (http://www.proz.com/) — tulkotaju un automatizétu tulkosanas riku forums, kura art ir
pieejama tehniska atbalsta sadala.

Tehnisko atbalstu ir iespéjams sanemt, vérSoties pie programmas izstradataja tehniska atbalsta
komandas ar $is veidlapas palidzibu — gateway.sdl.com/webtocase, vai sazinoties ar KSolutions pa e-pastu
software@ksolutions.eu.
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